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1 Using This Document 
The DatuSurvey™ User Guide will help you: 

 Understand the principles of operation of the software packages available from Datumate. 

 Plan and execute your fieldwork. 

 Use the software, make measurements, draw maps, and/or generate 3D Point Clouds and 
orthophotos from the images taken in the field. 

 

This User’s Guide applies to both software packages available under the umbrella of DatuSurvey™: 

 DatuSurvey Professional 

 DatuSurvey Enterprise 
 

Within this document, you will find comments, tips and answers to frequently asked questions. 
These are indicated by the following admonitions: 

 This icon signifies comments that are important for the user. They will help you make the 
maximum use of the DatuSurvey™ software. 

 

This icon signifies operational tips that may help you optimize your work in the field and 
in the office. 

 

 This icon signifies warnings that are important for the user. 
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2 Overview of DatuSurvey™ Packages 

2.1 Background 

DatuSurvey™ software (Previously DatuGram™3D) is a Field-to-Plan application allowing surveyors 
to make accurate geodetic measurements and draw draft CAD plans and maps directly from images 
photographed using standard digital cameras. DatuSurvey™ is applicable for surveying projects on 
a 1:250 scale, such as as-built surveys, volumetric analysis of stockpiles, geodetic mapping of 
buildings, roads, tunnels, junctions, engineering structures, forensic and accident scenes, mines, 
earth works, archaeological artifacts, film sets, and much more. 

Starting with Version 5.0.0 DatuSurvey™ will be available in two different packages: 

1. DatuSurvey Professional – This package is suitable for surveyors using traditional 
methodologies in order to generate 2D and 3D maps. 

2. DatuSurvey Enterprise – This package has all the functionalities of DatuSurvey Professional, 
but in addition has the capability of generating and working with dense point clouds as well 
as generating orthophotos. 

This manual describes the full functionality of all features covered by both packages, but features 
not available for a certain package are either disabled or not shown and the user will not have access 
to them. 

2.2 Principles of Operation 

The DatuSurvey™ software employs the principles of 
photogrammetry. Photogrammetry is the science of taking accurate 
measurements from photographs. The output of photogrammetry is 
typically a CAD map, plan, a drawing, or a 3D-model of some real-world 
object or scene. 

 

“photo” – light 
“gram” – drawing 
“metry” – measurement 
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Figure 1: Principles of Operation of DatuSurveyTM 

DatuSurvey™ automatically calculates the internal camera system parameters using a simple 
automatic self-calibration procedure, thus allowing the user to use any regular digital camera (1 – 
Figure 1). When uploading the images, DatuSurvey™ employs image processing and bundle 
adjustment algorithms to automatically calculate the relative orientation of the images (2 and 3 – 
Figure 1), such that only two of the images must be geo-referenced. Subsequently, DatuSurvey™ 
automatically locates any point the user marks on one image in at least two additional images (4 – 
Figure 1), thus allowing DatuSurvey™ to apply triangulation to find the 3D-coordinates of the new 
point. This permits users to draft objects directly on one image while the application automatically 
finds them in all other images, thus eliminating the need for stereoscopic digitization of images. 
Moreover, DatuSurvey™ allows the automatic extraction of a digital terrain model (DTM) of the 
survey area. This is highly useful for topographic surveys and volumetric analyses. While drafting on 
the images, the surveyor may use templates containing layers and codes. Consequently, the 
generated 3D model of the survey area may be saved in CAD DXF file format, so that it can be opened 
for further processing in any CAD software package. 

As a result, DatuSurvey™ streamlines and accelerates the Field-to-Plan process, i.e., the process of 
capturing field data and the drafting of CAD maps and models from the data. 

2.3 Working with DatuSurveyTM 

Working with DatuSurvey™ is very simple. 

 

Figure 2: Working with DatuSurvey™ 

2.3.1  In the Field 

The surveyor takes multiple photographs of the surveyed object or the survey area from different 
angles (1 – Figure 2), and measures the coordinates of several (minimum of three) reference points 
(or control points) using a total positioning station (TPS) or an RTK device, in either a local or national 
grid (2 – Figure 2), or alternatively measures two or more slope distances. The control points are 
used to geo-reference the images, i.e., anchor the images to the local or national grid, and the slope 
distances are used to correctly scale the whole project allowing the user to view correct 
measurements. 
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2.3.2  In the Office 

The surveyor uploads the images to the DatuSurveyTM software. It automatically associates all 
images to one another, by employing advanced image processing algorithms that find homological 
tie points and similar features, calculating the relative orientation of the images. Optionally, the 
surveyor can load the TPS measurement file of the control points and digitize at least three of the 
control points in at least two of the images each in order to geo-reference all images to the local or 
national grid. Alternatively, the surveyor can choose to add scale-only without control points or geo-
referencing (without orientation and position), by adding two slope distance measurements in two 
images each. Both geo-referencing and scale are optional, hence it is possible to build and see a 
model without measurements. 

Users may then draft their CAD model directly on the images, or automatically generate a DTM for 
any topo-surface that appears in the images (3 – Figure 2). The DatuSurveyTM software ultimately 
produces a DXF file of the generated 3D CAD model, as well as a file that lists all the points that were 
measured from the images, specifying their names, associated codes, and (x,y,h) coordinates, as 
well as the accuracy of each measurement, i.e. the (x,y,h) residuals for each point. 

In addition, the surveyor may opt to highlight, on the geo-referenced images, any additional points 
that were measured by field crews. In this way, the user may verify the quality of the measurements 
undertaken by field-crews and identify and correct, in the office, any discrepancy in the field 
measurements. 

 

 

Figure 3: Typical DatuSurveyTM Work Area Showing Control Points 

2.4 Accuracy of Measurements 

In geo-referenced or scaled jobs, the accuracy of measurements made on the images by 
DatuSurvey™ depends on the following parameters: 
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 The camera resolution and the distance between the camera and the measured object. The 
accuracy of measurements made on the images by DatuSurvey™ is a factor of the camera’s 
resolution and the proximity to the measured object. Typically, an 18-megapixel camera 
provides a 1 to 2 centimeter (3 to 6 hundredth of a foot) measurement accuracy at a distance 
of about 100 to 150 meters (110 to 160 yards, 330 to 480 feet). 

 The precision with which measurements in the survey area are done. This refers to the 
coordinates of the reference control points or to the measured distances. These should be as 
exact as possible as they set an accuracy baseline for all the measurement and drafting related 
to the images. When you measure ground control points, make sure you have several of them 
on a surface showing a very clear feature, such as marks on the ground or marks on walls. This 
will assure that a very precise measurement is taken. If you try to measure building corners 
using an RTK device you may have to move away slightly from the corner to make sure that the 
laser is indeed locked on the corner. 

 The maximum angle between images of the surveyed area. The accuracy of measurements 
made on the images by DatuSurvey™ is impaired when the maximum angle between images of 
the surveyed area is less than 30°. For best measurement accuracy, the maximum angle 
between images of the surveyed area should be close to 90°. This applies only when images are 
taken in oblique mode and not in vertical mode. 

 The scattering of the control points or measured distances and the accuracy of digitizing them 
in the images. For best measurement accuracy, control points for image geo-referencing should 
be chosen on the perimeter of the surveyed area and measured distances should be as long as 
possible so that measurements made on the images by DatuSurvey™ are interpolated, rather 
than extrapolated, from the measured distances or points. Moreover, control points should be 
well distributed in 3D space, i.e., relative to both depth and height, and digitized as accurately 
as possible in the geo-referenced images. For more details on measuring control points in the 
field, please refer to Chapter 4. 

Various quality control measures in DatuSurveyTM provide the user with detailed information about 
the accuracy of measurements. Firstly, after the images have been geo-referenced, DatuSurveyTM 
verifies the accuracy of the image geo-referencing or scaling by comparing the relative orientation 
of the control points or the distances to the relative orientation of the images. The Geo-Referencing 
Quality Indicator or Scale Quality Indicator provides a color indication (green, yellow or red) of the 
accuracy of the referencing of the photogrammetric model. Furthermore, after calculating the 
coordinates of the new points measured from the images, DatuSurveyTM provides the accuracy of 
each measurement, i.e., the (x,y,h) residuals for every point. 
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3 Installing DatuSurveyTM 

3.1 System Requirements 

The DatuSurveyTM software is designed to work on commonplace office PCs and standard laptops. 

 Operating system requirements 

o Windows 7: Enterprise, Ultimate or Professional (64-bit only) with latest service pack. 

o Windows 8.1: Enterprise or Professional (64-bit only). 

o Windows 10: Enterprise or Professional (64-bit only). 

 DatuSurvey™ works only under 64-bit operating systems. The 64-bit environment 
provides enhanced support for larger numbers of images and superior responsiveness. 

 CPU and hard disk requirements: 

o CPU: minimum Intel core i7. 

o CPU RAM: minimum 16GB RAM; recommended 32GB. 

o Hard disk: SSD 256GB with minimum 100GB of free space; recommended SSD 512GB 
with minimum 200GB of free space. 

 Screen and graphics card requirements: 

o Display resolution: at least 1600X900 with True Color; recommended 1920x1080. 

 NVidia 750 GTX (required for DatuSurvey Enterprise); recommended NVidia 1070 GTX 
Connectivity requirements: 

o Available Internet connection for installation, activation and updates. 

 Compatibility: 

o DXF file format: DXF 2006 onwards. 

3.2 Installing DatuSurveyTM 

3.2.1  Important Information about DatuGramTM3D Backward Compatibility 

If you are installing a new version of DatuSurvey™, make sure the proper camera calibration is 
selected from the library as improved camera calibration always generates better results. All control 
points and objects defined in the prior version will be kept and may be used.  

 If you save the job in this version of DatuSurveyTM, you will not be able to open it in earlier 
versions. 
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3.3 DatuSurveyTM Licenses 

The following sections provide a general description of the licensing options. Some of the options 
mentioned below apply only to specific software packages.  Activation and validation of licenses 
requires internet access.  Offline options are available by contacting Datumate support.  

3.3.1  Stand-Alone Perpetual Software License 

A regular software license of DatuSurveyTM allows the installation of one copy of the software on a 
single computer or “seat”. This copy of the software may be re-installed on that computer, or 
transferred to another computer after uninstalling from the first computer. This type of license has 
no expiration date and it includes maintenance for one year. The maintenance agreement will need 
to be renewed on a yearly basis after the first year. Maintenance includes support and software 
updates. 

3.3.2  Stand-Alone Time-Based Software License 

A regular software license of DatuSurveyTM allows the installation of one copy of the software on a 
single computer or “seat”. This copy of the software may be re-installed on that computer, or 
transferred to another computer after uninstalling from the first computer. This type of license has 
an expiration date after which the use of the software will not be possible unless the license is 
renewed. This type of license includes maintenance support up until the license expiration date. 

The system will notify you if your license is about to expire. 

3.3.3  Network Perpetual Software License 

A DatuSurveyTM network license is intended for organizations that require the flexibility to be able 
to use DatuSurvey™ on several computers. The application can be used concurrently on a number 
of computers, or “seats” that were purchased. 

 

3.3.4  Network Time-Based Software License 

This is the same as the Perpetual Network License, except that it has an expiration date after which 
the use of the software is not possible unless the license is renewed. This type of license includes 
maintenance up until the license expiration date. 

The system will notify you if your license is about to expire. 

3.3.5  Stand-Alone Free Trial Software License 

A Trial software license of DatuSurveyTM allows the installation of one copy of the software on a 
single computer. This copy of the software may be used initially for 14 days, but maybe extended 
by Datumate support if needed.  The Free Trial License limits the size of the project that you can 
work on.  
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 Regardless of the type of license you have the activation method will be the same, and 
the validation of the license type and use will be managed externally by Datumate servers.  

3.4 Activating DatuSurveyTM 

If this is the first time the software is installed on your computer, the “DatuSurvey™ Activation 
License” shown below will open when you start the software. This will allow you to either start a 
free trial license or activate a full license.    

  

 

Figure 4: DatuSurvey™ License Activation  

 

3.4.1  Starting a 14 Day Free Trial. 

We assume here that you already went to Datumate’s web site (www.datumate.com) and 
requested to start a free trial, and you already received an e-mail explaining what to do, and 
already downloaded, installed, and started the software. 
 

1. Select the 14-Day Free Trial option in Figure 4  above, which will open the dialog below asking 
you to fill out some information.  Make sure you fill out all fields accurately and press the Submit 
Button.  Make sure you use here the same e-mail you used when you requested the free trial.  
This will simply close the dialog and activate the Free Trial license. 

 

http://www.datumate.com/
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2. Start the software again by clicking its icon on the desktop, which will show the dialog below.  
The window shows that you are using a free trial version and the number of days left for the 
free trial to expire. 

 

Figure 5 - License Activation for a Free Trial 

 

3. To continue using the free trial version simply press on the Continue button and use the 
software.   

4. The other two options in the window above is to request an extension of the free trial version 
or to activate a full license.   

a. Request a Trial Extension – Fill out the Extension Trial Request shown with you press the 
button, and wait for instruction from Datumate support. 

b. Activate License – Explained in the section 3.4.2  below.  

3.4.2  Activating a Full License. 

Here we assume that you have contacted Datumate sales staff and purchased a full license and 
received an email with the proper License ID and License Key.   
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To activate a full license regardless of the license type you have purchased, press the “Activate 
License” button either of the dialogs shown in Figure 4 or Figure 5 above.   The will open the dialog 
below. 

 

 

Figure 6 - Full License Activation 

Copy and paste the License ID and License Key from the email you received into the proper fields 
accordingly, and press the Activate button.  This will activate the full license and show the 
message below that activation was done successfully. If you do not get this message, you will need 
to contact Datumate support.  
  

 
 

Press OK, and start the software again to start using your full license.  

 

3.5 Reinstalling DatuSurveyTM 

You may reinstall DatuSurvey™ on the same computer any number of times. The installation process 
is identical to the initial installation process, and no activation is required. 

However, if any hardware changes have been made on that PC, such as CPU or hard disk upgrades, 
you may need to re-activate the software license. The re-activation process is similar to that of 
transferring DatuSurvey™ to a different computer (refer to Section 3.6.) 
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3.6 Transferring DatuSurvey™ to a Different Computer 

Each regular software license allows you to install the software on a single computer. You may 
transfer the software from one computer to another computer by deactivating the license on one 
computer and activating it on a different one. Before you start this process, make sure you have 
your License ID and License Key of your software, and then follow the steps below to transfer the 
license. 

1. Start the software on the current computer. 

2. Select the menu option Help/Deactivate License. 

3. Press Yes to confirm the deactivation on the following window, and you will get the message 
below confirming that deactivation was done successfully 

 

4. Press OK, to close the software 

5. Install the software on a different computer. 

6. Start the software on the new computer, and follow the steps described in section 3.4.2  
above to reactivate the license on the new computer. 

3.7 Upgrading DatuSurveyTM 

Datumate periodically releases software updates for DatuSurveyTM. These updates include new 
functionality, compatibility to new operating system versions, bug fixes, and more. These updates 
are available for customers who are registered with Datumate’s Annual Support and Update 
Program. 

If you are eligible for software updates, it is highly recommended to install them as soon as they are 
released by Datumate. Upon opening, the software will automatically check the availability of new 
versions and, if available, will notify the user about new version availability. Alternatively, to check 
for new software versions, click Help in the main menu and click Check for Updates. 

Checking for the availability of new versions requires Internet connectivity to Datumate’s 
website www.datumate.com. Please make sure you have proper Internet connectivity, and verify 
that your local Firewall does not block HTTP connection with Datumate’s website. 
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4 Field Work: Taking Photos and Measuring Control 
Points 

4.1 Choosing your Camera and Lens 

The following guidelines and recommendations will help you choose an optimal camera and lens for 
surveying work: 

Use a high-resolution camera. It is recommended to use a camera with at least an 18-megapixel 
resolution. Typically, an 18-megapixel camera provides a 1 to 2 centimeter (3 to 6 hundredth of a 
foot) measurement accuracy at a distance of about 100 to 150 meters (110 to 160 yards, 330 to 480 
feet). 

 DatuSurvey™ does not support images taken with cameras which have sensors greater 
than 36-megapixel because the application may not be able to contend with the resulting file size. 

 

 Use a camera with a large CCD/CMOS sensor. It is recommended to use a camera with a 
CCD/CMOS sensor size larger than 100 mm2. 
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Figure 7: Common CCD/CMOS Sensor Sizes Used by Digital Cameras 

A camera with lower resolution and smaller sensor size can be used but this will degrade 
the measurement accuracy and the performance of the automatic algorithms of the software. For 
example, an 8-megapixel compact or smartphone camera with a 40 mm2 sensor size will provide a 
measurement accuracy of 1 to 2 centimeter (3 to 6 hundredth of a foot) at a distance of only 30 to 
40 meters (32 to 43 yards, 96 to 129 feet). 

 Use a lightweight camera with Wi-Fi connectivity. It is recommended to use a camera with a 
body weight lower than 300 grams and Wi-Fi connectivity. This facilitates easier installation and 
operation of the camera on telescopic poles or small UAVs. 

 Use a wide-angle lens. It is recommended to use a wide-angle lens with a fixed focal length 
between 8 and 16 mm. The wide angle provides a sufficiently broad field of view (FOV) to capture a 
spacious area when in close proximity to the target. This enhances the quality of measurements for 
images. 
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 Use a lens with a fixed focal length. DatuSurveyTM requires that the camera’s focal length will 
not change after the calibration of the camera and during the photographing of the survey area. 
Thus, it is strongly recommended to use a fixed focal length lens, i.e., a lens without an optical zoom. 

 The recommended camera types that are particularly suitable for the requirements mentioned 
above are lightweight mirror-less digital cameras with interchangeable lenses and Wi-Fi 
connectivity. As of March 2016, the list of recommended camera models includes: 

o Sony A7R with full frame 35mm lens (36.4 megapixel, CMOS Sensor, 35mm format 
sensor = 861.6 mm2 sensor size, Wi-Fi connectivity, body weight 465 g) + Samsung 35 
mm fixed lens. 

o Sony Alpha ILCE-A6000 (24 megapixel, mirror-less, interchangeable lens, APS-C format 
sensor = 370 mm2 sensor size, Wi-Fi connectivity, body weight 285 g) + Sony 16 mm 
fixed lens. 

o Samsung NX Mini (21 megapixel, mirror-less, interchangeable lens, 1’’ BSI format 
sensor = 116 mm2 sensor size, Wi-Fi connectivity, body weight 158 g) + Samsung 9 mm 
fixed lens. 

o DJI Phantom 3– Professional and DJI Phantom 4 (12 megapixels, 35mm format sensor, 
20 mm fixed lens, FOV=94°). 

o DJI Phantom 4 Pro and P4P V2 (20 megapixels, 1’’ CMOS format sensor = 116 mm2 
sensor size, 8.8mm fixed lens, FOV=84°). 

o DJI Phantom 4 RTK (20 megapixels, 1’’ CMOS format sensor = 116 mm2 sensor size, 
8.8mm fixed lens, FOV=84°). 

o DJI Inspire 1Pro (X5 - 16 megapixels, 15 mm fixed lens, FOV =72°). 

o DJI Inspire 2Pro (X4S - 20 megapixels, 1’’ CMOS format sensor = 116 mm2 sensor size, 
8.8mm fixed lens, FOV=84°). 

o DJI Inspire 2Pro (X5S – 20.8 megapixels, 4/3’’ CMOS format sensor = 225 mm2 sensor 
size, FOV=72°). 

o DJI Mavic Pro (12 megapixels, 1/2.3pixelse), 28 mm fixed lens, FOV =78.8°). 

o DJI Mavic 2 Pro (20 megapixels, 1’’ CMOS format sensor = 116 mm2 sensor size, 28mm 
fixed lens, FOV=77°). 

o  

4.2 Photographing the Survey Area 

The following guidelines and best practices will help you photograph the survey area in an optimal 
way. Here you will find some general recommendations, as well as recommendations for taking 
oblique images and for taking vertical images. 

4.2.1  General Recommendations: 

 Use a drone to take images using Datumate’s automatic flight planner DatuFly™, if possible. 
This will increase the probability that images will be stitched into one cluster. 

 Make sure your images cover at least four ground control points (GCPs). Even though the 
minimum mathematical requirement to build a model is three GCPs, it is strongly recommended to 
use at least four. Thus, when control points are used, make sure that your images cover at least four 
with each one appearing in at least three images. 
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 Set your camera to maximum resolution. Note that some camera models are preset to 
photograph in a resolution lower than their maximum resolution. Make sure your camera is set to 
the maximum resolution provided. 

 Make sure camera is set to save the GPS location of the images. This is essential for vertical 
images and recommended for oblique images. 

 Take your images in good and consistent lighting conditions. Take all images in similar lighting 
conditions, preferably at the same time of the day. Avoid photographing the survey area during 
different times of the day. This will minimize changes in shadings and lighting conditions that may 
degrade the performance of the automatic image processing algorithms employed by DatuSurveyTM. 
Do not take or use images of dark areas. 

 

Figure 8: Examples of Changes in Shadings and Lighting Conditions 

 If you use a zoom lens, do not change its settings while taking images. Modifying the zoom 
setting changes a camera’s calibration parameters. Thus, use a lens with a fixed focal length rather 
than a lens with zoom capabilities. However, if you do use a zoom lens, set it to the widest field-of-
view and do not change this setting when photographing. 

4.2.2  Recommendations for Oblique Images: 

Oblique images will be used to survey small areas, intersections or façades. Normally such projects 
are considered small and the number of images taken is not substantial. 

 Ensure that every point you want to measure appears in at least three images which have 
been taken at different positions. The key principle of photographing the survey area is that any 
point you want to measure should appear in at least three images from different viewing angles. 
The best measurement accuracy will be attained if the maximum angle of photography between the 
images is 90°. 
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Figure 9: Achieving Optimal Measurement Accuracy 

 Elevate the camera above ground level to minimize foreground obstructions hiding features 
surveyed. Elevating your camera above ground level is a key success factor for employing close-
range photogrammetry. Elevating the camera above ground level helps avoiding low-lying 
foreground obstructions such as fences, cars, and near ground vegetation, thus generating images 
of the survey area with minimal obstructions. Moreover, some techniques used to elevate the 
camera above ground level, such as installing the camera onboard a small quad copter, allow a much 
faster process of photographing the surveyed area, thus significantly enhancing fieldwork 
productivity. 

Take photographs from an elevated vantage point, such as from the rear of a vehicle or from a 
building overlooking the survey area, or use a monopod to raise the camera several meters 
above ground level. Lightweight, portable telescopic poles intended for photography allow 
taking pictures from 6 to 10 meters (20 to 30 feet) above ground level. The camera can be 
controlled remotely by using the Wi-Fi function on a smartphone or a tablet. Another highly 
effective method to overcome obstructions is the use of small UAV copters. A UAV copter, flying 
at an altitude of 17 to 23 meters (50 to 70 feet), easily bypasses low-lying obstructions while the 
wide-angle lens of the camera (smaller than 16mm focal length) provides a very large field-of-
view. 

 

Figure 10: Overcoming Low-Lying Obstructions 

 Modify the camera’s elevation for each image. This will ensure optimal measurement accuracy. 

 

Figure 11: Modifying the Camera’s Elevation 
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 Take images only in landscape format. DatuSurveyTM does not support images in portrait 
format. If your camera is equipped with Auto Rotate functionality, set it on “Off” so that all images 
remain in landscape format. 

 

Figure 12: Correct and Incorrect Camera Positioning 

 Take a large number of images of the survey area from different viewing angles. The more 
images from different viewing angles you take of the survey area, the better the automatic 
algorithms will perform in associating the images and detecting new points. To achieve optimal 
results, take at least 20 to 30 consecutive images of your survey area from different viewing angles. 
It is possible to work with up to 500 or 700 images, depending on the image resolution, to cover a 
larger area. 

 Maintain a consecutive order of the images. While photographing the survey area, maintain a 
consecutive order of the images. This will ensure optimal performance of the automatic algorithms 
for associating images and detecting new points. If you do not do this you will need to manually 
order the images after loading them into the software which may be a lengthy process. 

 

Figure 13: Maintaining a Consecutive Order of Images 

 Surveying an object (façade, landmark, etc.). To survey an object, such as a façade or landmark, 
take 20 to 30 consecutive images as you walk along the object. Take a new image every few meters 
while keeping the camera centered on the center of the object. Elevate the camera above ground 
level to minimize obstructions, and slightly modify the elevation of your camera between images. 
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Figure 14: Surveying an Object 

 Surveying an area (intersection, bridge, etc.). To survey an area such as an intersection or 
bridge, take 20 to 30 consecutive images of the area’s perimeter. Take a new image every few 
meters while keeping your camera focused on the center of the surveyed area. Elevate the camera 
above ground level to minimize obstructions, and slightly modify the elevation of your camera 
between images. 

 

Figure 15: Surveying an Area 

4.2.3  Recommendations for vertical images:  

Vertical images are used to survey large-scale areas, stockpiles, and long roads. All projects that fall 
under this category should be photographed using a slalom path, meaning going back and forth 
taking images to cover the whole area. All images should be taken along the long flight paths. 

 Maintain proper overlap. It is recommended to maintain at least a 75% front overlap and a 65% 
side overlap. 

 Surveying a long road. Defining the slalom flight trajectory over a road can be done in one of 
two ways, flying the long paths parallel to the road or across it. Flying parallel to the road permits 
taking less images, but it might cause traffic problems since one or more cars travelling in the same 
direction of the drone might appear in many of the images. While flying across the road will require 
more images, but traffic is easier to filter out. 

 Keep projects manageable. To keep projects manageable divide them into sections or areas. 
For example, divide roads into sections of about 1,500 meters (one mile) in length. Or if you have 
many stock piles, cover each or a few stock piles separately.  
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4.3 Geo-Ref / Scale 

 

 

Figure 16: Selecting a Referencing System 

You can choose between Geo-Ref., Scale, Rough Scale or Geo-Tag as the referencing system for a 
specific job cluster. 

In order to select Geo-Ref, control point measurements from the field are required. These are 
marked on images in order to add position, orientation, and scaling to your output or 3D model. 

Scale selection allows you to add scaling to your output or 3D model without any special surveying 
tools. Scaling only is achieved by measuring two slope distances in the field and then marking each 
distance on two images each. It can be very useful for volume calculation since it requires scaling 
only and there is no need for position or orientation to calculate volume. 

Alternatively, it is possible to work without geo-referencing or scaling by selecting the Rough Scale 
option. This will basically allow you to start working on the model while ground control points or 
distances are being measured. When implementing this option you will need to mark one rough 
estimate of a distance on two images. This option can also be used for quickly generating views for 
different purposes such as presentations, where measurements are not necessary. In both Scale and 
Rough Scale mode you are also required to set the gravity direction. 

Finally, the Geo-Tag option allows you to use the image geo tagging data to set your scale and gravity 
options. This mode is also approximate and similar to the Rough Scale option. 

4.3.1   Measuring Control Points for Image Geo-Referencing 

The following guidelines and best practices will help you measure your control points in the survey 
area in an optimal way: 

 Measure at least four control points in the survey area of a small project. At the minimum, 
each control point should appear in three of the images of the survey area, and should be 
photographed from different angles or vertical locations, as close as possible to 90°. It is very 
strongly recommended to measure and mark four or more control points. Measuring and marking 
more control points in additional images will improve the resiliency of the geo-referencing process, 
assuming that the measurement of the control points is accurate itself. You may measure point 
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coordinates in either a local or a national grid. The software will allow you to work with three control 
points marked in two images each. 

 

Figure 17: Measure at Least Three Control Points 

 Measure at least one control point every 40-50 meters on each side in elongated survey areas 
such as roads, and if possible, also try to measure points at different elevations.  

 Measure as many control points as possible of large scale areas. It is very important that you 
cover all safely reachable areas, especially on the perimeter of the area of interest. 

 Choose clearly defined control points. Choose control points that have a high contrast to the 
area around it and which will be unambiguously and accurately identifiable in the images. Use 
available landmarks or deploy your own prominent objects in the survey area if no appropriate 
landmarks are available. Good choices for control points are pointed shapes on flat surfaces such as 
painted street marks, or painted corners, tiles or stone patterns on building walls, etc. Corners of a 
building or tips of objects are only good for confirming the other control points. Avoid using 
extended objects as control points as well. 

 

Figure 18: Choose Clearly Defined Control Points 

 Avoid measuring points on slanted surfaces. This is specifically important when using a Total 
Station with in reflector-less mode. 

 Accurately measure the position and elevation of the control points. Carefully measure the 
position and elevation of control points with an accuracy of better than 2 cm (0.79 inch). Make sure 
you mark the exact and not the approximate location of the measured points on the sketch. 
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Remember, the accuracy of measuring the position and elevation of control points sets the accuracy 
baseline for all the measurements and drawings related to the images. 

 Scatter the control points in the survey area. To attain maximum accuracy, scatter your control 
points across the survey area relative to breadth, depth and height. Select control points on the 
perimeter of the survey area, so that measurements in the survey area are interpolated rather than 
extrapolated. Make sure that they are well-scattered in the survey area. 

 Choose control points on more than one plane. To attain maximum accuracy, select points at 
both ground level and elevated positions. 

 

Figure 19: Choose Well-Scattered Control Points 

Make sure your control points are not all located on the same plane, such as at ground 
level or on a vertical flat façade. Choosing control points that lie all on the same plane will degrade 
the accuracy of the geo-referencing of the photogrammetric model. 

 

Figure 20: Control Points Measured on Many Planes 
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4.3.2  Measuring Distances for Image Scaling 

The following guidelines and best practices will help you measure distances in the survey area in an 
optimal way: 

 Measure at least two distances in the survey area. At a minimum, two distances should appear 
in two of the images of the survey area, which should be photographed from different angles, as 
close as possible to 90°. Measuring and marking more distances in additional images will improve 
the resiliency of the scaling process. 

 Choose clearly defined distances. Choose distances that will be unambiguously and accurately 
identifiable in the images. Good choices for distances are distances between pointed objects such 
as the corners of a building or street marks. 

 Accurately measure distances. Carefully measure the distances with an accuracy of better than 
1 cm (0.4 inch). Remember, the accuracy of measuring the distances sets the accuracy baseline for 
all the measurements and drawings related to the images. 

 Choose distances on more than one plane. To attain maximum accuracy, select distances at 
both ground level and elevated positions. 
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5 Calibrating Your Camera 
Before processing your images with DatuSurveyTM, it is important that you calibrate your camera, 
i.e., calculate the internal parameters of your camera and lens system. This includes the camera and 
lens focal length and radial distortions. DatuSurveyTM takes the initial values of these parameters, 
readjusting them to compensate for any changes in the camera’s internal parameters due to the 
automatic focus of the lens or environmental conditions such as ambient temperature changes. 

Note that the internal calibration parameters are different for different camera bodies and lenses, 
thus the calibration procedure should be repeated whenever a new camera body or lens is used. 
DatuSurveyTM will save the calibration parameters of multiple cameras and lenses that you use. Also 
note that the calibration parameters change when using an optical zoom, and thus it is 
recommended to use lenses with a fixed focal length, i.e., not equipped with an optical zoom. 

Replacing your lens or using a new camera body requires recalibrating the camera and lens 
and saving the new calibration parameters in DatuSurveyTM. 

 

As part of the installation process, predefined camera calibration parameters are available 
for some cameras and if you intend to use one of these cameras, you can save time by selecting one 
of the pre-calibrated calibrations. Despite using our best practices and the job results are not 
suitable, you may need to calibrate your camera rather than rely on the pre-calibrated calibrations. 
Indications for that might be multiple clusters or poor accuracy. 

5.1 Calibration Procedure 

Calibrating the camera and lens includes the following steps: 

 Photographing the survey area or alternatively using a subset of images of a job to be processed. 
See Section 5.2 for best practice for taking or selecting images to be used in field calibration. 

The images can be sent to our support team who can create the calibration file for you. 
You can then simply import it into your library and use it. To do so, send the images to 
support@datumate.com. 

 

 Loading images to DatuSurveyTM. 

 Getting initial camera parameters from one of the available sources including automatic 
extraction of internal parameters from images. 
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 Running the calibration process and saving this new calibration. 

 Linking the images using the newly generated calibration file. 

 Adding floating control points in the Geo-Ref/Scale stage and using the “Apply” function to get 
an adjusted calibration. 

 Saving the final adjusted calibration to the calibration library. 

To calibrate your camera, simply follow these simple steps: 

 Click New Calibration... from the Images tab (Figure 21: left) or click Main Menu -> Tools -> 
New Calibration… (Figure 21: right). 

    

Figure 21: New Calibration 

 

 Select one of the available sources for getting the initial camera calibration values in order to 
be able to run the calibration (Figure 22). 
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Figure 22: Selecting a Calibration Source 

 Adjust camera and lens parameters if needed, click Calibrate, and wait for the calibration 
process to end (Calibration Successful). 

 

Figure 23: Calibration Process 

If an existing calibration is selected from the library or from an existing job, mismatches 
may occur due to incompatibilities between current images selected for calibration and the 
calibration file. Depending on the degree of divergence, click Finish or perform a new selection. 

 

When data is extracted from the EXIF metadata, the focal length [px] may not be identified 
during the process. Manually fill in the sensor width if it is not there. The sensor width data can be 
retrieved from the camera maker or any professional camera web site. 

 

If parameters are missing or there is a conflict with the EXIF data, you will be requested to 
select the “Custom” option to edit various fields. 
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 Click Finish and the “Calibration Name” window (Figure 24) will allow you to confirm or modify 
the automatically generated name of your new calibration and optionally uncheck/check the 
checkbox to add it to the Calibration Library. 

 

Figure 24: Calibration Name Window 

The new calibration will automatically be selected in the “Choose Calibration” dialog box (Figure 
25). 

 

 

Figure 25: Choose Calibration Dialog Box 

 If images were taken using an RTK drone with the RTK mode turned on, check the “Images taken 
in RTK mode” check box to take shown in the figure below. 

 

Figure 26 - RTK mode 

 Click Link to link the images. Once the link process is done, the link result is displayed in the right 
panel (Figure 27). If the image set is selected carefully and according to the best practices, only 
one cluster will be generated. 
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Figure 27: Link Result Window 

 Click “Next”, or alternatively click on the “Geo-Ref/Scale” tab to move to the Geo-Ref/Scale 
stage. 

If more than one cluster is generated, select only one of the clusters in order to continue 
the calibration process. The final goal in this stage is to add floating control points that will generate 
an adjusted calibration, which will be saved (exported) and used. 

 Select the cluster you want to work with if more than one exists. 

 Use any of the available model options, Geo-Ref, Scale or Rough Scale, as long as you have 
enough information to satisfy the minimal requirements. For example, keep the cluster model 
as a Rough Scale model, and add one Rough Scale and gravity to satisfy the minimal 
requirements of a Rough Scale model. Refer to Section 6.4.3 for details. 

It is preferable to work in Geo-Ref or Scale mode, but if you use the Rough Scale mode 
make sure the distance you use is reasonably close to reality. The Geo-Tag option is superior to the 
Rough Scale mode when geo-tagging information is available on the images. 

 

 Add additional floating control points to better relate images to each other. Refer to 
Section 6.4.10 on how to add FCPs. The more FCPs you add the better your calibration will be. 

 Click the Apply button, review residuals, and make adjustments following the standard work 
process until you are satisfied with the results. (Figure 28). 
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Figure 28: Typical Preparation for Calibration Adding FCPs 

 Select the menu option “Tools/Export Camera Parameters” (Figure 29). This will open a window 
that will allow you to select the cluster of which the adjusted calibration will be exported. 
Exported calibration can be imported into the calibration library at any time using the import 
function in the “Calibration Library” window. 

 

 

Figure 29: Exporting Adjusted Camera Calibration 

5.2 Field Calibration Image Set 

This section describes the best practices for taking or selecting images to perform camera field 
calibration. 

 Refer to Section 4.2 on the best practice for taking images for jobs where illustrations are also 
available. 

 DO NOT use images with sky, water or flat sand lacking features. 

 DO NOT use images with a lot of glass showing reflections. 



 
 

 

- 32 - 

 DO NOT use images with moving objects in them, such as traffic. 

5.2.1  For UAV Cameras: 

 Take between 30 and45 images in a circular mode with equal intervals between them, and from 
distances of about 15-20 meters. 

 All images should be directed to a center point with a minimum 70% overlap between them. 

 Take oblique image at 45 degrees. 

 Images should have low frequency texture such as a stock pile, a rock, or an intersection. 

5.2.2  For Ground Cameras: 

 Take between 12 and18 images following an arc with equal spacing between them, taken from 
distances of about 15-20 meters. 

 Do not use images that were taken in a straight line. 

 All images should be directed to a center point, with a minimum 70% overlap between them. 

 Images should have low frequency texture. 

5.3 Calibration Library 

 Click Tools > Calibration Library… in the main menu of DatuSurveyTM. 

 Click Add, Edit, Delete, Import or Export to modify camera calibration files. 

o Add allows manually adding a new camera calibration file to the Calibration Library. 

o Edit permits modifying the calibration parameters to incorporate external parameters 
or to change the MSE. 

o Delete permits removing a specific camera calibration from the Calibration Library. 

o Import permits importing a camera calibration file into the Calibration Library. 

o Export permits exporting the selected camera calibration file. 
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Figure 30: Camera Calibration Library 

As part of the installation process, predefined camera calibration parameters are available 
for specific cameras. The internal calibration parameters vary for each camera. If the job results are 
not suitable when using pre-calibrated parameters, you may have to calibrate your own camera.  
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6 Working with DatuSurveyTM 

6.1 Starting DatuSurvey™ Application 

The DatuSurvey™ application includes a series of opening screens which provide essential 
information about basic requirements and getting started. 

 If you do not want these pages to be displayed the next time the application is opened, unclick 
the “Show this at startup” checkbox. 

 

 

Figure 31: A Few of the Startup Windows 
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Figure 32: Welcome Screen 

6.2 Working with Jobs 

6.2.1  Opening a New Job 

To begin working with DatuSurvey™ – with photographs and measurements of a new area – open a 
new job. 

 At any stage in working with DatuSurvey™ you can undo (Ctrl+Z) and redo (Ctrl+Y) most 
of the steps performed. 

Once you have progressed to the next image or stage in the project, your work cannot be undone. 
Undo/Redo activities are per viewed-image or screen. It you move to another image, all actions 
which were “remembered” for Undo/Redo are lost. 

 Click File > New Job in the main menu of DatuSurveyTM, or use the shortcut Ctrl+N. 

 



 
 

 

- 36 - 

Figure 33: New Job Dialog Box 

 Fill in the Job Name in the “Job Name” dialog box. Use a standard naming convention that 
includes information such as the façade address, date of photograph, camera model and lens 
focal length, e.g.: CityName_StreetName_Date_Canon600D_24mm. 

 Select the method of image taking. When vertical is selected, and images have geo-tagging 
information, the link process will use the GPS position of the images to decide which images 
should be matched together. This means that images do not need to be ordered in a certain 
way for the link process to work. Select the Oblique method only of one circle of images is being 
used, otherwise if multiple circles were photographed or a mixture of vertical and oblique 
images are to be processed, make sure you select the Vertical method.  

 Select the Job Units.  The default units is selected, but you may change it here.  

 Specify the Coordinate System.  Here you can specify the Datum and Coordinate system you 
would like your output to be in.  Once this is set, you will not be able to change it. 

 Click OK. 
 

6.2.2  Opening an Existing Job 

To open an existing job: 

 Click File > Open Job in the main menu of DatuSurvey™ or use the shortcut Ctrl+O. 

 Browse to the DatuSurvey™ Jobs folder, click the Jobs folder, select the Job file, and click Open. 
The images are displayed in the “Images” window (Figure 35). 
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Figure 34: Opening a Job 

 If not previously selected in the “Choose Calibration” box, select the appropriate camera 
calibration from the list of calibrated cameras. When possible the system will automatically 
select a suitable calibration based on the camera and lens model, and a notification will appear 
below the “Choose Calibration” drop down. 

 Starting with DatuSurvey™ version 4.7.0 an improved camera calibration has been 
employed to generate a better model. Opening a job that was saved using a version prior to 5.0.0 
requires the user to go into the calibration library and select a new camera calibration. 

 Optional: Click New Calibration… in order to create a new camera calibration (refer to 
Chapter 5). 

 Optional: Click Tools > Calibration Library… in the main menu, in order to import a new camera 
calibration to the list (refer to Chapter 5). 

 If needed, click on Link to link the images. This may be required if you change the camera 
calibration or if the job was created using certain prior versions of DatuSurveyTM. This step also 
may result in the clustering images into groups that may need to be manually linked together. 
This topic is covered later in this chapter. 

 Click Next. The “Geo-Ref/Scale” window is displayed. After clicking OK, the “Images” window is 
displayed and performing job’s tasks can be initiated. 

6.3 Step 1: Images – Loading Images, Camera Calibration, Linking 
Images and Managing of Clusters 

There are five main steps to complete in order to handle a job from start to end. This section 
describes the first step followed by steps 2 to 5. 

The first screen displayed after a job is opened is the “Images” window (Figure 35). In this window, 
you handle the imagery of the job: loading images, removing images, calibrating the camera with 
which the images were taken, and geometrical linkage of the images. 
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Figure 35: Load Images Window 

 Click Load Images, and in the “Choose Images” window browse to the folder in which the image 
files are stored.  

 Select the relevant image and click Open. The system starts a process which includes part or all 
of the following: 

o Sanity check – Checking for EXIF data issues, such as resolution and date mismatch. 
Sanity check takes some time. It should be performed only when images are loaded and 
not when a saved job is opened. 

o Loading images – Copying images into job folder. 

o Image Preparation – Preparing all different images for job. 

o Blurriness check – Checking if any of the images have blurry areas (This is an optional 
step which may be turned on or off in the Advanced Settings tab under the 
Tools/Setting menu option) 

The selected images are then displayed in the “Images” window.  
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Figure 36: Images Window 

Both the Sanity check and the Blurriness check may result in issues that require resolution. 
Such issues are indicated by a warning sign on the image and also by a digit(s) showing the number 
of images with warning/issues (on the bottom left side of the Images screen). These issues can be 
resolved by right clicking on each screen and selecting the resolution action. 

 

 Once images are loaded, click the “Map View” option “  “ shown at the top left corner 
of the window to view the locations of the images layered on top of a map as shown in Figure 
37. If an internet connection is not available, the background of the display will be black. 
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Figure 37: Map View of Geo-Tagged Images 

 Click on any image to open it in a new window. 

 Right click on any image to show additional options-- to delete one image or select images one 
at a time and then delete all selected images. Alternatively multi-select several images using a 
standard mouse function. 

 Images initially have a white marker, but after the link process is complete, each cluster 
will have its own color.  When selected, they will have a yellow marker. 

 

 

 Choose Calibration: If not automatically selected, select the appropriate camera calibration 
from the list of pre-calibrated cameras. If the camera in which images where taken does not 
exist on the list, then the camera must be calibrated. Click New Calibration… in order to create 
a new camera calibration or click Tools > New Calibration … in the main menu (Refer to 
Chapter 5). 

 Set the RTK Mode if applicable – This will allow the system to take in account that the images 
have precise locations and handle properly in the link process. 

 Select Auto Generate Dense PC - This option will be available in the DatuSurvey Enterprise.  
Check it if you would like the system to generate a preview only dense point cloud at the end of 
the linkage process.  To generate a precise anchored dense point cloud, you should Geo-
Reference the model in the Geo-Ref/Scale step, and only then generate the dense point cloud 
in the View & Export step. 

 

 Click Link. The images are automatically linked in clusters (groups of linked images) based on 
homological points. 
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If your images have GPS data, the link process will be based on the GPS location of the images; 
hence there is no need to order images in the “Images” tab. If no GPS data exists on the images, 
then the link process will be based on the sequential order of images in the “Images” tab. 

6.3.1  Short Baseline Issues 

If the link process detects consecutive images with short baseline issues (images that are very 
similar), then the system will indicate this fact on the right side of the screen and will automatically 
open a window to allow the resolution of this issue by deleting some of the images. If you select not 
to resolve some or all of the issues, the message will remain on the screen with an option to click 
Resolve…” to go back and rectify the situation. As shown in Figure 38 the images are grouped and, 
by default, all are marked for deletion except for the first one in each group. Once you click OK, 
marked images will be deleted and images will have to be linked again. 

 

 

Figure 38: Resolving Short Baseline Issues 

6.3.2  Manually Linking Image Clusters 

If the angles of photographing are extreme, images cannot be automatically linked into a single 
cluster and several unlinked clusters are created. Each image is marked in its bottom left corner as 
to which cluster it belongs to. The list of clusters is shown on the bottom right side of the screen. 
The list initially shows only main clusters in cases where the number of images in these clusters is 
greater than 20% of the images linked. Use the “Show all clusters” link to show the rest of the 
clusters in the list. Only clusters with three images or more will be shown. This is also true in any 
window where a cluster list is shown. 
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Figure 39: Multiple Image Clusters 

You may select to ignore the fact that you have multiple clusters and continue your work dealing 
with several clusters in the jobs, which can be handled separately throughout the job as sub-jobs. 
Otherwise, you have the option to attempt to connect the clusters by adding tie points. 

 Manually connecting image clusters is a feature available as an advanced function. If it is 
not available, and you do wish to use it, use the menu option “Tools/Settings” and activate it in the 
“Advanced” tab. 

 To connect image clusters, click the Cluster Connector button, which opens the window shown 
in Figure 40. 

 

Figure 40: Cluster Connector 
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 Add sets of six or more tie points between each two clusters that appear to be linkable.  

These sets of tie points are called connectors. It is possible to add one or more connectors 
between any two adjacent clusters, but each one of the connectors needs to have a minimum of six 
tie points. 

 

If all images were initially linked into one cluster, no merging is necessary and the Cluster 
Connector button is not displayed. 

If a large number of clusters include one particular image, change the order of the images so that 
they reflect their actual appearance in the field where they were taken. 

 

 To add cluster connectors, click Add below the connector list. 

 

Figure 41: Adding a Cluster Connector 

 Select two clusters from the drop down list and click OK. This will automatically select the last 
two images of the first cluster and the first two images of the second cluster (Figure 41). 
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Figure 42: Adding Manual Tie Points for a Cluster Connector 

 Click Add in order to add at least six tie points on all shown images (located below the manual 
tie point list). 

 Left click to mark the tie points on all the images. 

 Zoom images as needed to identify and mark points. Once the third tie point is marked on all 
images residual values will appear indicating how good your markings are. 

 When sufficient tie points have been identified, click OK and link images again. 

 Once you are happy with the link process and cluster result, then you can move forward to Step 
2 = Geo-Ref/ Scale. 

Upon loading the images, DatuSurvey™ automatically calculates the relative orientation 
of the images by finding homological tie points through state-of-the-art image processing 
algorithms. 

6.3.3  Viewing Clusters in 3D 

After a successful link is completed, the “3D View” option “  “ at the top left corner becomes 
available to show the Point Cloud in a 3D viewer (refer to Figure 43).  If a dense point cloud was 
automaticlly generated after the link, this viewer will show the dense point cloud, otherwise it will 
show the sparse point cloud generated by the link process. 
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Figure 43: Sparse Point Cloud Display 

6.4 Step 2: Geo-Ref / Scale 

Starting with version 5.0 you have the option of selecting one of four working modes for each one 
of the clusters (refer to Figure 44). 

 

 

Figure 44: Model Referencing Modes 

For Geo-Ref and Scale clusters, you may define as many control points and as many scaling distances 
as you want. For Rough Scale clusters, you will be able to define only one approximate distance. For 
Geo-Tag mode, you do not need to define anything. The system will set the project orientation and 
the scaling based on the image geo tags. Adding GCPs and your scaling distances will be described 
later on in this section. 

While working with any of the four modes it is possible to add floating control points (FCPs) to 
strengthen the coherence between images. This improves the accuracy of all functions, especially 
when the project includes a large number of images. FCPs are basically control points without 
coordinates. So you may define any clear feature in two or more images and it becomes a control 
point, and you may define as many control points as you want.  
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 To add an FCP under any mode, use the ( ) tool bar button and click anywhere on the image 
to add a new FCP or mark an existing FCP. Refer to Section6.4.5 detailed instructions. 

The following sections provide directives in regard to how to work with the different modes. 

6.4.1  Working in the Geo-Ref/Scale Stage 

The “Geo-Ref/Scale” tab sets the basis of how accurate the model will be. Regardless of which mode 
you are in, if you start correctly in this stage, then everything will be accurate throughout the whole 
project. This is particularly important when you work in the Geo-Ref or Scale mode as this will set 
the geo referencing or scaling. When working in Rough Scale or Geo-Tag modes, it is assumed that 
accuracy is not as important at this stage, but it could be later on if you decide to switch the job back 
to either Geo-Ref or Scale mode. 

For each mode there are some minimal definition requirements the system needs in order to be 
able to refine the camera position and orientation parameters so they will minimize projection 
errors. This refinement calculation is referred to as “Bundle Adjustment”. The Bundle Adjustment 
calculation can be re-done at any time to improve the refinement of the parameters, and can also 
be based on different points including GCPs, FCPs, new points (not including topo points), and 
distance end points. The more points you use the better the refinement, but it takes more time. 
These minimal requirements are mentioned in other places in this document, but for your 
convenience they are provided here once again: 

 Geo-Ref minimal requirements – A minimum of three ground control points marked in two 
images covering a span of about 90 degrees. Meaning that you should mark each control 
point on at least two images where the angle between the first and the last image is close 
to 90 degrees. However, it is strongly recommended to mark 4 GCPs and mark each one in 
at least three images. 

 Scale minimal requirements – A minimum of two distances marked in two images with the 
gravity direction set. The two images should cover a span of about 90 degrees as explained 
in the Geo-Ref minimal requirements. 

 Rough Scale minimal requirements – Only one distance marked in two images with the 
gravity direction set. The two images should cover a span of about 90 degrees as explained 
in Geo-Ref minimal requirements. 

 Geo-Tag minimal requirements – No marking is required. The system will use the image 
location in the EXIF data which is the basis for orientation and scale. 

Once the minimal definition requirements are met for the selected image cluster, the system will 
calculate the refined parameters.  

Click Apply. The Running Bundle Adjustment calculation is activated. 
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Figure 45: Clicking the Apply Button to Activate the Running Bundle Adjustment Process 

 

Each time Apply is clicked, the system performs a full refinement calculation (Sparse Bar Adjustment 
– SBA). This provides marking accuracy residuals for GCPs, FCPs and distances depending on the 
mode in which you are working. Once this refinement is done, you can add, adjust, or delete points 
or distances. When this is done, the system gives a message that the model has changed and you 
need to click Apply. It immediately updates the marking residuals for the point that was changed 
using a quick transformation calculation. Therefore, it is not necessary to click Apply after every 
change. 

Once you have completed your Geo-Ref, Scale, or Rough Scale and point adjustments, click Apply 
again. This will recalculate the referencing allowing you to go to the “Measure & Draw” function. 
Finally, when you finish all your markings, you click Apply. During this process, the system will re-
calculate the coordinates of all the new points, including topo points, and it will display the progress 
bar (Figure 46). Once done, it will move to the selected tab. 

 

Figure 46: Calculating New Point Coordinates 

The following are general recommendations for adding control points or distances for each cluster 
of a new project. 

6.4.1.1 Geo-Ref Clusters 

 Satisfy the minimal requirements. Add a minimum of three ground control points (strongly 
recommend 4 GCPs) on at least two different images (strongly recommend four GCPs on at least 
three images each) as distant as possible from the edges of the images. When marking ground 
control points, select images with about 90 degrees between the first and last one. Make sure 
the ground control points appear around the outside of the area of interest. This ensures that 
the values will be interpolated and not extrapolated. 

 In large-scale projects photographed vertically, especially long roads, you should mark enough 
control points to cover the whole project. For example, mark control points in the beginning, 
middle, and end of the road. 

 Click Apply. If the residuals are not satisfactory, go back and check your markings and adjust 
where needed. Click Apply again until you have good residuals, i.e. all residuals are green. 
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 Turn on projections. 

 Start checking images that are distant from the original images (where you marked the GCPs) 
and determine if the projections are where they should be. If needed, add more ground control 
points and/or floating control points to improve the projections. Be certain that every control 
point is added to at least three images. 

 Once finished click Apply again. 

 Repeat steps 4 and 5 until you are satisfied with the projections. 

 You may then move on to the “Measure & Draw” function. 

6.4.1.2 Scale Clusters 

 Satisfy the minimal requirements. Add distances and set the gravity. When adding the first set 
of distances, select two images that are about 90 degrees relative to each other. Make sure the 
distances appear in both of them. Try to use distances that are not very short in relation to the 
area of interest. 

 Click Apply. If residuals are not satisfactory, go back, check your markings and adjust where 
needed. Click Apply again until you have good residuals. 

 Add more distances and/or floating control points to strengthen the ties between the images. 
Make sure you distribute the new distances and floating control points throughout the entire 
cluster. 

 Click Apply again and check residuals. 

 Repeat steps 3 and 4 as required. 

 You may now move to the “Measure & Draw” function. 

6.4.1.3 Projections of GCPs, FCPs and Distances 

The projections of Control Points as well as Distance end points can be shown on other images. 

 Click Apply on images in the same cluster. A model is built and then projections are shown. 

 To turn projections on simply check the “Projections” check box in the upper right corner of the 
Geo-Ref/Scale screen (Figure 47). 

 

Figure 47: Projections Check Box 

 To select what will be projected click the Projections Check Box (Figure 47). This will open the 
“Projections Settings” window Figure 48 which will allow you to make your selection. The 
Projection Settings here are global and not for a specific cluster. Thus, they can be set and saved 
for a job regardless if there are control points or distances in the job. Projections of floating 
control points and distances projections will be made in the cluster they are marked in, while 
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ground control points’ projections will be marked in images in any Geo-Referenced cluster if 
possible. 

 

Figure 48: Projection Settings 

The Custom… link allows you to select a subset of ground control points to be projected. 
The “Projection List” selection window is shown in Figure 49. 

 

Figure 49: Projection List Window 

General Guidelines 

 GCPs are projected only in Geo-Referenced clusters. Selections made here also apply to the 
“Measure & Draw” window but may also be changed there. 

 FCPs are projected in all cluster types only in the Geo-Ref/Scale stage. 

 Distance Points are projected only in Scale and Rough Scale clusters only in the Geo-Ref/Scale 
stage. 
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6.4.1.4 Show Names 

In the Projections Check Box, check or uncheck the “Names” checkbox to show or hide the 
point and projection names on the images. 

6.4.2  Working in Geo-Tag Mode 

Working in Geo-Tag mode with non RTK drones or camera means that the model will be built with 
the following characteristics: 

 Anchored: The anchoring will be based on the image geo-tagging information available in 
the EXIF data of the images. You are not required to set gravity or scale.  The model will be 
generated using the Datum and Coordinate system of the images. 

 Roughly scaled: Meaning that it will have approximate dimensions. The model will be built 
based on geo-tagging information. 

Working in Geo-Tag mode with RTK drones or camera means that the model will be built with the 
following characteristics: 

 Anchored: The anchoring will be based on the image RTK geo-tagging information available 
in the EXIF data of the images. You are not required to set gravity or scale.  The model will be 
generated using the Datum and Coordinate system of the images and will have precise x/y 
positioning. The Z position or the elevation will not be accurate but may be adjusted using the 
country undulation file or by a set value.  

 Precisely scaled: Meaning that it will have precise dimensions. The model will be built based 
on RTK geo-tagging information. 

6.4.2.1 Undulation Correction for Geo-Tagged RTK jobs 

Adjusting the elevation of the Geo-Tagged model is possible by using an undulation file, by a fixed 
adjustment, of by both.    When Geo-Tag anchoring is selected and the job was marked as an RTK 
mode job in the Linkage step, the undulation correction fields will appear as shown in the figure 
below.  

 

Figure 50 - Undulation Correction 

Both file and manual height adjustment are applied when “Apply” is pressed.  Both values are 
subtracted from the model height values.  The Undulation file units may be selected, while the 
height adjustment automatically uses the job units. 
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When you press file browse button to select an undulation file, the window below pops up and 
allows you to select the proper undulation file.  In addition to selecting a file, pay attention to select 
the correct format from the dropdown list of options.   

 

Figure 51 - Undulation File Selection 

6.4.3  Working in Rough Scale Mode 

Working in Rough Scale mode means that the model will be built with the following characteristics: 

 Floating: It is not anchored to the ground and does not have a perfect orientation. You are 
required to set the gravity direction so the model will be vertically correct, but it will not have the 
correct azimuth (angle from north). 

 Roughly scaled: It will have approximate dimensions. The model will be built based on the 
specified Rough Scale but it will have the right aspect ratios. 

This mode is useful for the following purposes: 

 To build a model for a presentation to show the concept or advancement in building processes 
or excavations or filling processes without the need to have control point measurements. 

 Images exist from a particular job, but ground control points or distances have not yet been 
measured. In this case it is possible to start all the drawing processes and when the survey area is 
measured, ground control points or distances can be added, and the work can be completed. 

To work in Rough Scale mode, simply select Rough Scale for a specific cluster, follow the instructions 
to define one rough distance and define the gravity similar to what is described in “Working in Scale 
Mode” (Section 6.4.4 ). 

Click Apply and go to “Measure & Draw” function. Rough Scale names will start with the letter “R” 
indicating the measurement was roughly estimated. 

6.4.4  Working in Scale Mode 

Working in Scale mode allows adding a measurement reference to the job. This facilitates taking 
accurate measurements between new points, as well as building scale sized models. All this can be 
done without any special surveying tools. Scale mode is ideal for stock pile volume calculations, 
since volume calculations do not require geodetic positions or orientation. 

Scale is easy and can be done by measuring as few as two distances in the field, then marking these 
measurements on at least two images. When distances are added, the Distance Marking Accuracy 
measured will provide residuals for both the distances and for end points. This will be shown in the 
right pane of the application similar to the “Control Point Marking Accuracy” table. 
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To add a distance while working in Scale mode follow the steps below: 

 Select the distance marking tool  from the tool bar. A distance marker with the number 1 
is attached to the mouse pointer. 

 Mouse over to the first termination of the distance you wish to mark, and click it. Zoom in as 
needed to mark the right point.  

 You are prompted to determine if what you are adding s is a new or an existing distance. If this 
is a distance that you have previously marked on other images, click Existing (Figure 52). If this 
is a new distance, enter the measured distance in the field that is displayed (Figure 53). 

 

Figure 52: New or Existing Distance 

  

Figure 53: Setting the Measured Distance 

 If you picked an existing distance, select one of the available distances from the drop down 
option (Figure 54). 

 

Figure 54: Selecting an Available Distance 

 Click OK, and a distance marker with the number 2 is attached to the mouse pointer. 

 Mouse over to the other end of the distance marked, and click on it. Zoom in as needed to mark 
the right point. 
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 Repeat these steps to add more distances as needed. All distances will appear in the Distances 
list as shown below in Figure 55. 

 

Figure 55: Scaling Distances 

 Define the model gravity by clicking on Define Gravity. If images have GPS data, the system will 
try to define the gravity vector based on GPS data automatically. If it succeeds to do so, it will 
display a message below the Define Gravity button saying that Gravity was defined 
automatically. Otherwise, a dialog (Figure 56) will be opened to allow the user to define the 
gravity vector manually. 

 

Figure 56: Defining Gravity Dialog 

There are two ways to define gravity direction. One is by a vertical line in one of the images. 
If no vertical line exists, a horizontal plane can be defined. Both definitions use existing points 
including GCPs, FCPs or distance end points. If you do not have suitable points, you will need to add 
FCPs for this purpose.  
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 Make your selection and click OK. The mouse cursor turns to this icon . 

 Select points as instructed. Each point you select will be marked clearly with this icon . 
Additionally all points that are participating in the gravity setting will be clearly marked with the 
letter G in the list of points or distances on the top left part of the Geo-Ref screen.  

The software will do its best to detect the direction of the gravity based on the images, 
but you will always have the option to reverse the software’s detection with a click of a mouse on 
Flip Gravity in the 3D Model screen under the “View & Export” tab. 

 Once you satisfy all the requirements of distances and gravity, click Apply and then move on to 
the “Measure & Draw” function to continue your work. 

6.4.5  Working in Geo-Ref Mode 

Control points are the measurement points taken in the field using traditional geodetic 
measurement equipment, such as a robotic total station or RTK GPS. With DatuSurveyTM, there is no 
need to collect dozens of measured points in the field as is done conventionally. You only have to 
measure a few well-identified points that are uniformly spread over the job’s area. Each control 
point should be a measurement of an object existing on at least two images. The number of required 
control points is a factor of the complexity of the site but new control points can easily be added as 
you move forward so there is no need to overpopulate an image. For the best practices of marking 
ground control points and accuracies see Appendix 1  

6.4.6  Importing Ground Control Points 

The ground control point measurement file, containing the project’s control points, should be 
imported at this stage. 

 Click Import and select the measurement file. The “Import Measurement” window is populated 
by the control-points data measured in the field. It is recommended to have a text file (.txt, .pnt, 
or .csv) of your field measured control points. 
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Figure 57: Selecting the Control Points File 

  

Figure 58: Import Measurements Window – View of TP (Control Points) File, Prior to Import 

 The “Import Measurements” window (Figure 58) shows how DatuSurvey™ parses the control 
points’ file. If the parsing is not correct, you can set the correct delimiter, change (by dragging) 
the order of the coordinate columns, and set the decimal separator. The default measurement 
unit is in meters but you can change it by selecting other units from the dropdown list. 

o The “<filename> content preview” field shows the original text as it exists in the file. 

o The “<filename> filtered preview” field shows the interpretation of the file in which the 
contents have been parsed to Name, N, E, H (coordinate values), Code name, 
Description and Point Comment. 



 
 

 

- 56 - 

 To save the formatted parameters, click New and provide a Format name for the New Format 
(Figure 59). 

 

Figure 59: Saving Import Measured Points, Format Interpretation 

 To delete a format setting item from the “Format Settings” list, select the item from the 
dropdown list and click Delete. 

 To save a format settings item in the “Format Settings” list, click Save. 

 If point attributes within the TP file are ordered differently from the default order, columns can 
be dragged and reordered. 

 Use the Start Import at Row, Delimiter, Units of Coordinates and Decimal Separator to modify 
the formatted imported parameters. 

 If control points were measured in a coordinate system different than what was specified for 
the job, you may elect to have them converted.  To do so, check the Convert Coordinate System 
check box, and select the coordinate system that was used for measuring the control points.  

 Click Import. DatuSurvey™ checks the control points to verify that a point with the same name 
does not already exist in the job. If it does, the application prompts the user with a dialog box 
to skip, rename or overwrite the existing point. 

During the import process, a control point with a code that already exists in the job’s codes 
library receives that particular code. Other control points remain without codes. 

6.4.7  Marking Control Points 

Images are anchored by control points. Reference points, before being anchored, are called 
projections. Projections as well as marking residuals are shown after meeting the minimum marking 
requirements. Figure 60 shows the basic “Geo-Ref/Scale” window followed by an explanation of its 
components. 
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Figure 60: “Geo-Ref/Scale” Window 

6.4.7.1 Left Pane 

Control Points – This is a list of all imported or manually added ground control points and floating 
control points. If the control point is marked on at least one image, an anchor icon is shown to the 

left of the control point name. The icons are different for GCPs  and FCPs both on images as 
well as on the table on the top left. In (Figure 60) four control points are marked on at least one 
image. 

Images below control points list –All the images in which the selected control point appears are 
shown with the control points marked.  Additionally, a hint of where the selected ground control 
point may be in other images.  Hints are given based on Epipolar line calculation and will start 
appearing as an Epipolar circle hint after the model is built by pressing the Apply button the first 
time. The user may then scroll down and select the image they wish to mark the GCP in.  The hint 
will also appear in the main image display as shown in the figure below. 
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Figure 61 - GCP Hints on Image Thumbnails and Main Image 

6.4.7.2 Right Pane 

Show Names and Projection – These check boxes enable and disable showing the names of the 
control points and the projections as well as showing the projections themselves. 

Click Projections… to select the points that you would like to see projections for. Projections are 
shown after meeting the minimum marking requirements. 

Clusters – A list of image clusters built by the link process with the option to select the referencing 
mode for each cluster. 

Select a cluster from the list to show the thumbnail images of the selected cluster as well as one 
of the cluster images on the center display. 

GCP Residuals [m] –The system shows the point with the highest residual in the actual 
measurement unit (meters, feet, etc.).  

Click Details… to show all marked points residuals without having to go to the “View & Export” 
screen. 

Control Points Marking Accuracy – Residuals of all markings are shown here. Values are 
automatically shown after meeting the minimum marking requirements and are updated every time 
a point is added, deleted, or moved. Colors of residuals indicate their quality. Ranges for each color 
may be set in the “Tools/Settings” option in the “Accuracy Display” tab. 

6.4.7.3 Bottom Thumbnail Banner: 

Thumbnails of all selected cluster images are shown here.  

Click or drag an image to the main image display to work with it. 

On each thumbnail there are two indicators (Figure 62). In the upper left corner the number of 
control points is marked, and in the upper right corner the color of the overall tie point detection 
accuracy on this image is indicated. 
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Figure 62: Thumbnail Banner 

On the upper right corner of the banner click one of the following options: 

o Map View… - If images are geo-referenced, the map view is available. It also allows you 
to select the image that will be displayed in the “Geo-Ref/Scale” tab for processing and 
adding control points. 

o Show All-Show images of all clusters. 

o  Opens an expanded view of images. 

6.4.7.4 Main Image Display: 

The Main Display is where all work is done as far as marking and editing the control points. There 
are two ways of displaying images for marking control points in them.  Selection of which way to 

show images in may be done by using the selection options  that appear above the 
main display. Figure 63 below shows the full image selection (Left option).  This way is the only way 
that can be used until the minimal control point marking requirement is fulfilled, which is marking 
3 points in 2 images each.  Once the minimal requirement is fulfilled, it will be possible to show and 
use the grid option (Right option), which is shown in 

 

Figure 64  below.  Using the grid method shows only images that the selected point is marked or 
projected in it.  Images are shown zoomed in to the area of the mark of the projection.  This way it 
is possible to quickly adjust or mark a point by clicking on the image showing a cross hair line, and 
clicking again to mark it. 
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Figure 63: Full Image Option 

 

Figure 64: Grid Zoomed Option 

  To view information about one or more control points, click the Indicator icon ( ) and mouse 
over the desired control point. The control point will be highlighted and if Names was not 
previously checked, the name of the highlighted point will be displayed. 

 Right-click a control point to display a context menu. This permits performing several actions on 
the point, including displaying the Properties of the point. The same context-menu appears if 
you right-click on a control point on the “Control-Points” list in the left pane. 

6.4.8  Anchoring Control Points 

To anchor a previously defined ground or floating control point on images: 

 Select a cluster (group of linked images). 
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 Select an image from the selected cluster by clicking on images or dragging to the viewer from 
the thumbnail banner images from images in the left pane. 

 Click the Point Selection icon ( ). A crossbar cursor appears over the image. 

To zoom in on a particular area of an image, use the scroll wheel on the mouse to adjust 
the size of the image. 

 

To scroll through an image, right-click and hold the mouse right button and drag the image 
in any direction. 

 

 Zoom into the area of where you want to mark the control point, put the cursor on the right 
position and left-click to mark it. The “Mark Control Point” dropdown box is displayed. 

Note that the projection marker is used to assist in finding the vicinity of the point. Put 
your mark on where the point was originally measured in the image and not on the projection 
marker itself. 

 

 Click on the arrow in the “Name” dropdown box (Figure 65) and select the relevant control point 
based on its name and the field sketch (or image) detailing the control points measured in the 
field. 

 Click OK. 
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Figure 65: Marking Control Points 

 Repeat this process until you have marked at least three ground control points and as many 
floating control points on at least two images. It is recommended that you distribute the points 
to identify the width, length and height of the project. 

Revising the position or coordinates of a control point will change the geo-referencing of 
the photogrammetric model, and will change the coordinates of any new point measured on the 
images. 

 To edit ground control point properties, click the Indicator icon and then right-click on the 
control point, on the image, or in the list of control points to provide a list of operational 
functions related to each control point. 

 

Figure 66: Control Point Context Menu 

o Click Select in Viewer to highlight the selected point and display its name. 
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o Click Rename to rename a point without changing its coordinates. 

o Click Replace with to replace the point’s name and coordinates with one of the points 
in the TP measurement file. 

o Click Delete to remove a point from the list. Several options are provided: 

 Delete point from entire job. 

 Delete mark from this image only. 

 Delete mark from all images. 

o Click Properties to manually edit the point coordinates (Figure 49). 

 

 

Figure 67: Editing Control Point Dialog Box 

 Subsequent to the creation of each new control point after meeting the minimum requirements, 
the application will recalculate and display the residuals. If residuals become faulty after adding 
a point, recheck the position of that point in all images in which it is marked. 

 Click on any of the points shown in the “Control-Points” list (left pane) to display all images that 
contain that particular point. Thumbnails of the images are shown below the “Control-Points” 
list. 

 Click on a thumbnail in the “Control-Points” list (left pane) to display that image in the main 
window. 

To locate a particular control point, use the “Search” window located at the top of the 
“Control-Points” list. 

6.4.9  Adding a New Ground Control Point 

If a control point is deleted, all its projections will be removed. Similarly, if a control point is restored 
(using the undo function), all its projections will be restored. 
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If an important projection is missing in the TP measurement file, a new control point can be created. 
The relevant information with the required parameters should be provided by a surveyor who 
worked in the field. 

 To manually add a new control point click the “+” button below the “Control-Points” list. 

 In the “New Control Point” window, fill in the coordinates and other related information. 
Provide a code (if available) and description and click OK. The Code is only relevant when 
provided for a measured point by the TPS. 

 

 

Figure 68: New Control-Point Dialog Box 

6.4.10  Adding a New Floating Control Point 

 To add a new floating control point, Click the Point Selection icon ( ). A crossbar cursor 
appears over the image. 

 Click on the location on the image where you want to add the new floating control point (Figure 
69). 

 

Figure 69: Adding a New Floating Control Point 
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 Click on the New FCP button, and it will add a floating control point named FCP_x, where x is a 
sequential number assigned by the system. Once you add a new point on one image you can 
anchor it on other images following the same method as adding a pre-defined ground control 
point. 

6.4.11  The Geo-Referencing/Scaling Marking Accuracy Indicator 

Marking accuracy calculation should be performed in the following instances: 

 After marking at least three control points on two images in the survey area. 

 Whenever any of the existing control points (GCP or FCP) are edited. 

DatuSurveyTM calculates the geo-referencing of the photogrammetric model based on ground 
control points, floating control points and distances in the images. It compares the relative 
orientation of the images inferred from the geo-referencing to the relative orientation implied from 
the automatic image processing of tie points. Additionally, the user may also include or exclude all 
points mentioned above, as well as new points drawn on the images in the calculation by setting 
the SBA (Sparse Bundle Adjustment) options in the SBA tab of the settings window. 

The color of the Marking Accuracy Indicator (green, yellow or red) indicates the accuracy of the 
photogrammetric model. A green light indicates the accuracy is good. A yellow light indicates that 
accuracy of the photogrammetric model is fair, and a red light indicates that accuracy of the 
photogrammetric model is poor. 

 To recalculate the photogrammetric model, click Apply button at any time. 

 Check and edit the exact anchoring of any control point that has large residuals, as indicated by 
a yellow or red marking, by comparing it to the field sketch. 

 Repeat this procedure until the Marking Accuracy Indicator is green, or when you are satisfied 
that the marking accuracy meets your minimum requirements. 

6.4.12  Marking Accuracy List 

Marking accuracy determines the difference between the marked position and the calculated or 
predicted position of any point. All residuals are important because they show how accurate the 
marking is. The residual is determined by taking the predicted value and comparing it to the marked 
value. 

Image marking accuracy residuals are always measured in pixels so that their absolute value in 
centimeters or inches is relative to camera resolution and the distance between the camera and the 
object. 

DatuSurvey™ is pre-configured so that measurement errors smaller than three pixels are colored in 
green, measurement errors of three to four pixels are colored in yellow, and measurement errors 
larger than four pixels are colored in red. These parameters are configurable by the user in the 
“Settings” window (refer to Section 7.2.1 ). 

1 Check and edit the exact anchoring of any control point that has large residuals, as indicated 
by yellow or red markings, by comparing it to the field sketch, and recalculate the geo-
referencing of the photogrammetric model. 

2 Click on any point in the residual list in order to view thumbnails under the “Control-Points” list 
(left pane) of all images containing that particular point. 
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6.4.13  Export Camera Calibration 

In the event that the job results are suitable you can use this particular job for future internal camera 
calibration. Suitable results are indicated by the existence of a single cluster with the Geo-
Referencing Quality Indicator being acceptable (green). 

 In the Tools menu, select Export Camera Parameters. 

 In the Tools menu, select the Calibration Library… option and import this new Calibration file 
by clicking on the Import button and selecting the file recently saved. 

6.5 Step 3: Measure & Draw – Marking and Creating New Points 

The survey drawing is created on this window. To perform this function, you can add map entities 
such as New Points, Polylines, Polygons or Surfaces. Furthermore, linear distances between two 
points can also be measured. Remember that when you have more than one cluster, each is handled 
separately. Thus, New Points or objects marked on one image will be projected on images from the 
same cluster only. 

To establish the coordinates of a new point, the point must be identified on at least two images, 
and preferably more. Any new point marked in one image is automatically found in all others. 

A number of tools are available on the “Measure & Draw” window to facilitate the process of 
creating a survey drawing. 

 

Figure 70: Measure & Draw Window 

6.5.1  Layers and Objects 

6.5.1.1 Working with Layers 

A layer is used to group several map entities into one set. Usually, entities of one layer have some 
common attributes that distinguish them from points in other layers. For example, they may define 
a window frame layer or a road sign layer. Layers are defined across a job, so they can be used in 
any cluster. 
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The various layers in DatuSurvey™ can be checked or unchecked in the “Layers” list in the Show 
column. This substantially reduces the possibility of confusion if you wish to visually concentrate on 
a specific group of entities. 

By default, when DatuSurvey™ opens a new job, it contains one layer called the “default layer”. 

Right-click on a layer to call up its context menu which has the following options: 

o Delete Layer – deletes the layer and all its contents. 

o Properties –shows the “Layer Properties” window, containing layer name, description 
and color and enables editing those properties (Figure 71). 

 

Figure 71: Layer Properties Window 

To create a new layer: 

 Click on the + below the “Layers” list in the right pane to open the “Add Layer” dialog box (Figure 

72). 

 

 

Figure 72: Add Layer Dialog Box with Color Selection Dropdown Box 

 In the “Add Layer” dialog box, add a name for the new layer and a description and click on the 
Layer Color button to open the “Color” selection dropdown box. 
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 Select a color for the layer. The color assists the user in quickly identifying entities in a particular 
layer. 

 Click OK. 

6.5.1.2 Working with Objects 

Each layer contains its map entities (objects) which are displayed in the “Objects” list below the 
“Layers” list. When you draw map entities, they are automatically associated with the selected layer 
in the “Layers” list. 

 Select an object, and a certain entity or list of entities will be highlighted on the image. 

 Right-click on an entity to show the context menu that enables the deletion of the entity. 

In the case of polylines and polygons, only the lines are deleted but not the new-point 
objects. 

6.5.2  The “Measure & Draw” Toolbar 

The “Measure & Draw” toolbar contains the tools presented in Figure 73: 

 

Figure 73: The “Measure & Draw” Toolbar 

The Selection and Indication tool is used to: 

 Drag and drop a point to move it, or select the point using a left mouse click, moving it by using 
the keyboard arrows in steps of 1-pixel resolution. 

 Move the mouse cursor over a new point to highlight a new point. When the new point is part 
of a polyline or a polygon, it highlights the connected lines and new points. 

 Select (left-click) a new-point entity to be synchronized with the “New-Points” list. 

 Activate (right-click) the context menu of a new point. 
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Figure 74: New-Point Context Menu 

The New-Point Marking tool is used to create a new point. 

The Polyline Marking tool is used to create a sequence of new-point entities. Each adjacent pair is 
connected by a straight line. 

The Polygon Marking tool is used to create a sequence of new-point entities. Each adjacent pair is 
connected by a straight line. The first new point and the last new point are connected forming a 
closed polygon. 

The Topo-surface Sketching tool is used to designate a polygon topo-surface border. After drawing 
the topo-surface border, DatuSurvey™ calculates a set of topographic points (topo-points) in the 
form of a points-cloud. This cloud represents the topography of the topo-surface enclosed by the 
topo-surface border. 

The Ruler Selection tool is used to measure the linear distance between two points. 

6.5.3  The New-Points List 

The “New-Points” list contains all the new-point objects in the job, whether they are standalone 
points or part of polyline or polygon. 

The “New-Points” list has an attached search box. Searching can be done by name. Typing a new-
point’s name will show the appropriate named points in the list. 

 Select a point from the “New-Point” list. Large image thumbnails are displayed below the list. 
These thumbnails refer to the images in which the selected New-Point is marked. 

 Right-click on a New-Point to display the New-Points list context menu. 

  Various functions are provided to manage new points, as shown in Figure 75. 

 

Figure 75: New-Point List Context Menu 

6.5.4  The New-Point Properties Bar 

The “New-Point Properties” bar is used to name new points and determine other related properties. 
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Figure 76: “New-Point Properties” Bar 

6.5.4.1 Using the “New-Point Properties” Bar to Mark a New New-Point 

To mark a new point, perform the following steps: 

 In the “New-Points Properties” Bar click New. 

 Access the “Naming” field. This field contains the name of the to-be-marked new point. The 
name is automatically created and is always one digit greater than the previous name. The 
following table provides examples of new-point names: 

 

Previous Marked New-
Point Name 

Current to-be-Marked 
New Point Name 

1 2 

100 101 

ABC ABC1 

ABC0 ABC1 

ABC01 ABC02 

72A 72A1 

 Alternately, in the “Naming” field type a desired name manually. This will be the name base for 
the following new markings until you type another name. 

 Use the “Code Selection” list box to select a point code from the existing list. 

6.5.4.2 Using the “New-Point Properties” Bar to Update an Existing New 
Point 

To select an existing new point: 

 Click Existing on the “New-Points Properties” bar. In the “Naming” field the name of the 
currently selected point is highlighted in the “New-Points” list. If another existing new-point 
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update is needed, select another point from the dropdown list. It will be synchronized with the 
“New-Points” list. 

 In the “Code Selection” list box, the code of the currently selected new point is displayed. You 
select another code for the existing point. 

In order to have selectable point codes in the “New-Points Properties” bar, you must load 
codes to the job’s codes library. Refer to Section 7.2.3.1. 

6.5.5  Viewing Images 

Marking entities on an image requires a high degree of accuracy. DatuSurvey™ provides three 
images viewing modes to facilitate precise positioning of your mouse. 

 For a single image view, in the image marking area, select one image – either from the 
thumbnails ruler at the bottom of the screen or from the “New-Points Image” list on the left. 
The selected image is displayed and occupies the whole image marking area. 

 For a split screen view, click on the split screen image in the “Screen Mode” bar. Drag and drop 
images from the thumbnails ruler into the screen quarters. 

Split screen mode is useful to assure a specific marking can be projected on several images 
or if you want to view existing new point projections or markings. 

 

Figure 77: “Images Screen Mode” Bar 

 To display an image in a separate window, right-click on the image in the “New-Point” list. A 
context menu pops up showing ‘”Preview” option. Select the option, and the image is opened 
in a new system menu. 
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Figure 78: Selecting Displaying Image in a Separate Window 

The “Preview” mode is useful if you are using two monitors. You can then drag the new 
window to another monitor and visually scan small features in the image. The image occupies the 
whole screen and can be zoomed and panned and a filtering checkbox allows you to show all new 
points on the image or just the selected one. 

6.5.6  Marking New Map Entities 

6.5.6.1 Creating a New Point 

To create a new point: 

 Select the layer (or create a new one) with which you want the new point to be associated. 

 Select the mapped item you want to mark. 

 Select the image/images that best display that item. 

 From the “Measure & Draw” toolbar, select the “New-Point” marking tool. 

 On the “New-Point Properties” bar, verify that the automatically-provided name is suitable. 
Modify the name if required. 

 Verify that the automatically-provided code for the new point is suitable. Modify the code if 
required. 
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 To add a comment to the new point you are about to mark, click on the Point Properties button 
and type the comment. 

 Position the crossbar cursor on the desired location on the image and click it. A gray-colored 
drop-shaped icon is displayed. On the right pane an indication is provided that object marks are 
being searched on other images. After several seconds, the search process is completed and the 
color of the drop-shaped icon changes to green, yellow or stays gray. The different colors 
indicate the following: 

 

Figure 79: Example of Auto-Find Indication 

o Green: indicates the point was found in at least two other images (apart from the 
currently marked one). 

o Yellow – indicates the point was found in only one other image (apart from the currently 
marked one). 

o Gray – indicates the image was not found in any other image. 

On a Yellow or Gray icon color marking, select another image and mark the current point 
manually as "Existing" point. After this action a new Auto-Finding process will start while 
the two manual marks will not be changed. 

Use Ctrl+mouse click to initiate a snap function to help you draw accurately. The cursor 
snaps onto each location, linking the points. 

6.5.6.2 Creating a New Polyline 

To create a new polyline: 

 Repeat steps 1 to 3 from Section 6.5.6.1 (Creating a New Point). 

 From the “Measure & Draw” toolbar, select the “Polyline Marking” tool. 

 Repeat steps 5 to 7 from Section 6.5.6.1 (Creating a New Point). 

 The first point of the polyline is created. Move the mouse to the location of the next point. A 
trailing line indicates that the new point will be marked as part of a polyline. 

 Repeat step 3 as many times as required until you reach the penultimate point. 

 To mark the final point of the polyline, double-click the mouse. A new polyline is created having 
the color of the layer with which it is associated. 
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During the process of marking new points for a polyline or a polygon, it is not necessary to 
wait until the search process has been completed for each point. Mark as many points as necessary 
and the process of searching points in other images continues in the background for all points. 

6.5.6.3 Creating a New Polygon 

 Repeat steps 1 to 3 from Section 6.5.6.2 (Creating a New Polyline). 

 From the “Measure & Draw” toolbar, select the “Polygon Marking” tool. 

 Repeat steps 5 to 7 from Section 6.5.6.2 (Creating a New Polyline). 

 The first point of the polygon is created. Move the mouse to the location of the next point. A 
trailing line indicates that the next new point will be marked as part of a polygon. 

 Repeat step 3 as many times as required, until you reach the penultimate point. 

 To mark the final point of the polygon and close it with a line connecting to the first polygon’s 
point, double-click the mouse. A new polygon is created having the color of the layer with which 
it is associated. 

While marking new polyline or polygon points, you can change each polyline’s or polygon’s 
new-point properties by setting them in the “New-Point Properties” bar. 

6.5.6.4 Creating a New Topo-Surface Entity 

 For each area you want to cover, such as a stock pile, create a layer specifically for it, and add 
all topo-surface for the area of interest under the newly defined layer. 

We recommend creating special layers that include only topo-surface objects. This ensures 
that only the desired topo-surface features are included in the mesh. 

 Repeat steps 1 to 3 from Section 6.5.6.2 (Creating a New Polyline). 

 From the “Measure & Draw” toolbar, select the “Topo-surface sketching tool. 

 If this is the first topo-surface in the job, DatuSurvey™ presents a message stating that pre-
processing is required. This takes several seconds. 

When creating a new topo-surface, you cannot change the name of the topo-surface. It is 
provided automatically. 
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 Circumscribe the topo-surface you want to reconstruct (calculate its topography) with a 
boundary polygon (use the same techniques as described in marking a new polygon, 
Section 6.5.6.3). You must define several topo-surfaces to cover the area of interest or the stock 
pile. Topo-surfaces can be drawn on different images, but must be under the same layer. 

 When each topo-surface boundary is closed, DatuSurvey™ displays a process notification in the 
right pane stating that it is calculating topo-points for the drawn topo-surface. This process takes 
several seconds and when completed, the topo-surface should contain several topo-points 
within its boundary. 

 

Figure 80: Topo-surface Reconstruction – Soil Pile Example 

A topo-surface’s boundary polygon is not composed of new-point entities. It is made of 
per-image points, so do not expect to find the topo-surface boundary in images other than the one 
used to draw it. 

 

To get accurate topo-points: 

o Choose images that have good contrast and no blurring. 

o Choose images that are not among the first two images and not among the last two 
images. 

o Ensure that the principal region in the Topo-Surface is visible in four images at least. 

Points which lie close together in the image of the principal region must also lie close together in 
the 3D, for example, in this case the topo-surface on the left image should not include both points 
but be split into two topo-surfaces. 
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6.5.7  Working with the Ruler Tool 

 To measure the distance between two measured points, select the Ruler icon. 

 Click on two points and the distance between them is shown in the “Ruler” dialog box. Points 
may be control points or new points. Three distances are provided: 

o Vertical distance 

o Horizontal distance 

o Slope distance 

 

Figure 81: Ruler Dialog Box 

6.5.8  Other “Measure & Draw” Window Properties 

6.5.8.1 Show Control Point Projections 

To show selected Ground Control Points projections, check the projections check box on the upper 
right corner and follow the procedure explained in Section 6.4.1.3 to select the ground control 
points to be projected. FCPs and Distances may not be projected. 

 The “Projections” window has a bottom part that you can simply ignore for this purpose. 
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6.5.8.2 Show Names 

Check or uncheck the “Names” checkbox to show or hide the point and projection names on the 
images. 

6.5.8.3 New Point Projections 

A new point projection is displayed as a small red square. There are two types of New-Point 
Projections.: 

Same Cluster Projections 

To create a same cluster projection: 

 Mark a new point on at least three images (but not on the current image) by clicking on a new-
point projection when in edit mode. 

After clicking on the new-point projection, the new-point projection (red square) will 
disappear. 

In addition to the red square, there are several other methods of new-point projection display: 

 An Epipolar line is a hint in regard to the location of the new-point on the current image when 
this point is marked only on one image (not the current image). 

 An Epipolar circle is a hint in regard to the location of the new-point location on the current 
image when this point is marked on at least two images (not on the current image). 

Figure 82 shows an example of new point projections in the same cluster. A polyline of two points 
was added in one image. One point was found in at least three images so it is shown as a red square 
projection, while the second one was found only in two images so it is shown as an Epipolar circle. 

 

Figure 82: New-Point Projection in Same Cluster 



 
 

 

- 78 - 

Cross Cluster Projections 

In these projections, both clusters must be geo-referenced. 

 Click Projections… to turn on projections and checks the cluster to be projected on other 
clusters.  

 Select the clusters in the bottom half of the expanded “Projection Settings” window (Figure 83). 
The new point drawn on an image in one cluster is displayed as an orange square on other 
clusters. Figure 84 shows two points projected from another cluster and two points projected 
from the same cluster. 

 

Figure 83: Expanded Projections Settings Window 

 

Figure 84: New-Point Projection on Other Clusters 
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 Snap onto any of the orange projections using the Ctrl button while adding new objects other 
than single points. 

New points will not be added at points projected from other clusters, hence in the 3D 
viewer in “View & Exports”, objects using cross cluster points will not be shown unless both clusters 
are shown. 

6.5.8.4 Creating Polygons and Polylines from Existing Points 

There are two types of New Point Projections: 

New-Point Projection in the same cluster – These are automatic projections. 

Cross Cluster New Point Projections – These are projections of new points between geo-
referenced clusters. The user has control over which clusters’ new points will be projected on 
the remaining ones. 

6.6 Step 4: Approve – Reviewing, Correcting and Approving 
Marked Points 

The “Approve” window is used to review and correct a job’s measurement points. Information about 
the reliability and accuracy of the points is presented in tabular form. This screen provides tools to 
search, sort and filter the points. You can view each point on all the images in which it appears, 
correct the locations of new-point entities or delete new points and topo points. 

6.6.1  Approving New Points 

The coordinates of all new points and their measurement accuracy are automatically calculated 
when the “Approve” window is accessed. The coordinates and error ellipses of the control points 
appear in the table in the left pane. When a point is clicked on, all associated thumbnails are 
displayed (Figure 85). You can move the location of new-point markings to improve accuracy. 
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Figure 85: New Points Approve Window 

6.6.2  Approving Topo Points 

The coordinates of all new topo points and their measurement accuracy are automatically 
calculated when the “Approve” window is accessed. The coordinates and error ellipses of the topo 
points appear in the table in the left pane. When a point is clicked on, all associated thumbnails are 
displayed (Figure 86). 

Topo-point locations cannot be edited. 

 

Figure 86: “Topo Points Approve” Screen 
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6.6.3  General Approval Guidelines 

The error ellipses of the measurements are presented in metric units. DatuSurvey™ is pre-
configured as follows: 

 Measurement errors smaller than 3 cm are colored green. 

 Measurement errors of 3 to 4 cm are colored yellow. 

 Measurement errors larger than 4 cm are colored red. 

These parameters are configurable by the user using the “Tools/Settings” function in the Accuracy 
Display tab. 

Measurement errors may be caused by (1) the point not being accurately sampled in the images, (2) 
the distance of the point from the camera being too great, or (3) an error in the software automation 
algorithms. To verify that the point is accurately sampled in the images: 

 Click on the desired point in the table in the “Approve” window. 

 Browse through the different images to view where the point was sampled and correct it as 
required. Images can be zoomed in so it is very simple to achieve very accurate positioning on 
the “Approve” window. 

 To delete one point, click on the line to highlight it and then click “Delete points”. 

 To delete several points, right-click on the lines to be deleted, one after the other, to highlight 
them and then click Delete. 

 Filter displayed points by selecting one of the following criteria and typing the name of that 
criterion. 

o New points can be filtered by name, layer name or code. 

o Topo points can be filtered by name, layer name or topo-surface. 

 If a specific point is inaccurate or erroneous, it can be deleted. To delete a single mark, click on 
the image and then click on the X (window closing) or on Delete Image Marks. To delete several 
marks, hold the Control key and click on several image windows, then click on Delete Selected 
Images. 

6.7 Step 5: View & Export – Previewing and Exporting to 
Exchangeable Formats 

In the “View & Export” window you can view all surveying map data created by DatuSurveyTM, and 
generate and export additional outputs such as volumes, dense point clouds, mesh and texture.  
Each output can be generated in one more exchangeable formats.  In addition, you can manage the 
content of the export by selecting the desired exported layer, control points (used, all, or none) as 
well as selecting some viewing options. 
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Figure 87: View & Export Window 

The “View & Export” functions are broken into 9 tabs that can be broken down into 3 groups as 
follows: 

1. “3D Model”, “Projection Preview”, “Control Points”, “New Points” and “Topo Points” – these 
tabs all relate to objects that were added by the user and may be exported as a 3D model to 
DXF format output. Additionally it deals with showing the Dense Point Cloud and Texture.  The 
right side panel of all of these tabs is the same and regardless of where you make a change or a 
selection, it will apply to all of the tabs.    Section 6.7.2 below describes in detail the different 
export options available.  

2. “DEM & Volumes” - This tab handles all functions related to generating digital elevation grids 
and volume calculation. Section 6.7.3 below describes in detail all functions related to volume 
calculation.  Section 6.7.4  below describes in detail all functions related to DTM grid generation. 

3. “Point Cloud Projection” and “OrthoPhoto” – these tabs all deal with functions related to dense 
point cloud; both generation and exportation.   

Some functions described above may also be available from other places in the software.  

6.7.1  View & Export Tabs 

The “View & Export” tabs provides views and information of the project from different perspectives, 
as well as providing different export options as follows: 

 3D Model: Displays a 3-dimensional view of the selected layers. The colors of the objects 
displayed in the 3D Model are in accordance with the colors of the layers as defined in “Measure & 
Draw”. This window has the following functionality: 

o Hovering over a point shows the point name. 

o Showing point names checkbox which allows you to hide or display the names of all 
measurement points.  When a dense point cloud overlay is selected, the names will not 
be shown even if this option is checked. 
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o Allows generating a Dense point cloud and a textured mesh by pressing the “Generate 
Dense Point Cloud…”, which opens the dialog that allows selecting what to generate.  
Refer to section 7.2.5 for more details.   

o Selecting the Dense Point Cloud view, if available, that will be overlaid on top of the 3D 
model. This does not affect the export options at all.  The overlay options as shown are 
None, Point, Mesh, or Mesh and texture.   In the same line of the overlay selection it 
also allows to export the overlays as shown below. 

 

Figure 88 - Exporting Dense Point Cloud Options 

 

o Clicking and holding the mouse’s right button to pan over the view. 

o Using the mouse wheel to zoom in and out. 

o Clicking and holding the mouse’s left button to rotate the view. 

o Right-click to get the option to reset the view based on available display space; Zoom 
Extent. 

o Use the top view reset button  to reset the display to top view. 

o Use the distance measurement tool  available in the toolbar on the right side of 
the display to measure distances between two point, including new points, tope points, 
or dense cloud points. 

o Use the area and perimeter measurement tool  available in the toolbar on the 
right side to calculate the area and perimeter of a polygon selected by clicking on at 
least 3 points.  
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You may encounter some false positive points in the job. Fix the false positive issue by 
moving the point marks manually in the "Approve" window or by selecting images one by one in the 
"Measure & Draw" tab. 

 

Sometimes the lines fail to appear when polygons or polylines are marked by snap to 
control point projections. To rectify this situation, select "Show all points" in the “Control Points” 
combo box. 

 Projection Preview: Presents a top-down view of the entities-to-be-exported, reflecting the 
vector-projection which has been set. If no-projection has been selected, nothing is shown. This 
window also provides panning and zooming. 

 Control Points: Gives a list-view of all control points positions and residuals in meters. 

 New Points: Gives a list-view of all selected new points. 

 Topo Points: Gives a list-view of all selected topo points.  Topo points referenced here are the 
only points that are a result of defining topo surfaces using the “Measure & Draw” as previously 
described in section 6.5.6.4. 

 DEM & Volume: Provides ability to calculate volume concealed in measured structures as well 
as generating DEM grids for exporting to DXF or PNT formats. Top View, Distance Measurement, 
DTM,, and Area Measurement tools are also available here as in 3D viewer.  DEM & Volumes is 
covered in detail in section 6.7.3  and 6.7.4  below. 

 Volume calculation requires that either Geo-Ref or Scale cluster be selected. It will not 
work on a 3D model without any scaling property. 

Grid generation requires a Geo-Ref cluster to be selected. 

   

 Point Cloud Projection: Available only in the Enterprise package. It allows the projection of 
selected dense points from the 3D cloud on a 2D surface and saving it to .PLY file formats (Figure 
89).  
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Figure 89: Point Cloud Projection 

 Adjust the boundaries of the area you would like to project by stretching the shown 
rectangles on the three views. 

 Rotate the cloud itself clockwise or counter-clockwise using the arrows available for that on 
the bottom right corner of the top view. 

 Once an area is selected click Project Point Cloud to show the top view projection. 

  Save or discard the projection. If you select to save it, you will be prompted to select one 
of more views out of the six sides of the cube to save, and all selected views will be saved 
in .PNG as well as the selected format in the selected folder.  In this version only .PLY format 
is available.  Other options will be added in the future.  

 Orthophoto: Available only in the Enterprise package. It allows the generation of an orthophoto 
of a cluster. The result will be saved in a tiled tiff format in a folder that has the name of the cluster. 
It is possible to generate a partial Orthophoto by selecting an area of interest in the same manner 
as selecting an area of interest for generating Dense Point Cloud.   This is explained in section 7.2.5  
below.  

6.7.2  Exporting Job Data 

To export the measurements as final output files or as input to CAD software for further processing, 
in the right pane, perform the following steps: 

 Select the layers to be included in the export by using the checkboxes to the left of the layers’ 
names. 

 Select which layers to mesh, by using the checkboxes to the right of the layers’ names. 

 Select which control points to include in the export (none, just the used control points or all the 
control points). 

 Select the output file format: DXF, ENH, NEH or PDF. 
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 Select the projection: 

o No projection. 

o Horizontal plane – set the H value of the horizontal plane. Type a specific value or set 
the height by selecting a new point from the list so its height will set the horizontal plane 
of reference. 

o Vertical plane – sets a plane, perpendicular to the horizon, which passes through two 
selected new points. All measurements, then, undergo vector-projection. 

 Click Export. 

Management of data in the “View & Export” window does not alter the data stored by 
DatuSurveyTM. Changes are made only for preview and export. 

6.7.3  Volume Calculations 

6.7.3.1 Background 

 

 

 

Figure 90: The DEM & Volumes Window 

The “DEM & Volumes” window (Figure 90) in the “View & Export” window is used to calculate 
volume of material enclosed within a relief structure. This is useful in construction works, earth 
works, tunneling and mining, where large quantities of soil have accumulated or are planned for 
excavation and measuring of such an aggregation is necessary. 

Volume calculation is done based on one surface or on two surfaces. In the first case, DatuSurvey™ 
creates a convex hull, a virtual surface enclosing the given physical surface, then the calculation of 
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the volume enclosed between the physical surface and the convex hull is performed. In the second 
case, DatuSurvey™ calculates the volume of material enclosed between two given physical surfaces. 

In the current version of DatuSurveyTM, in order to calculate a volume, the base surface, if defined, 
must fully include the selected surface (Figure 91). 

 

Figure 91: Supported Surfaces Geometry 

 

Starting with DatuSurvey V5.1, defining the physical surface (the stock pile) can be done in one of 
two ways, as follows: 

1. Define stock piles the traditional way, which is by defining a set of surfaces in “Measure & Draw” 
as described in section 6.5.6.4 above. This would be the only way available in DatuSurvey 
Professional.   

2. Define stock piles right on the dense point cloud as described in section 6.7.3.2 below.  This 
feature is available only in the DatuSurveyTM Enterprise package only. 

6.7.3.2 Marking stock piles on dense point clouds  

Starting in version 5.1, using DatuSurvey Enterprise, it is possible to mark stock piles right on the 
dense point cloud.  To do so, perform the following steps: 

 Make sure a dense point cloud was generated for the selected cluster.  

 In View & Export, select the DEM & Volumes tab.  The first time the tab is opened in a job, the 
window will look as shown in the figure below.  
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Figure 92 – DEM & Volumes Tab 

In the tool bar 3 tools may be used as follows:  

 - This tool is for viewing a specific layer in 3D.  It will allow rotation of the layer to allow 
viewing from different angles. See figure below. 

 

 

Figure 93 - Viewing Mode in Volume Calculation 

 - This tool is for sketching topo surfaces right on the dense point cloud. When clicked it 
will show the dense point cloud in top view, and if the selected surface does include some 
objects they will also be shown.  See figure below. 
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Figure 94 - Topo Surface Mode in Volume Calculation 

 - This tool is for defining a base surface that can be used as a base surface for other topo 
surfaces for volume calculation. Such surfaces may be cloned or flattened if needed using the 
hot menu options available on the surfaces list before they are used as a base surface.  As in the 
topo surface marking tool, when selected it will show a top view of the dense point cloud and 
objects in the selected surface. 

 Select the topo surface marking tool (  ) which will show a top view of the dense point cloud. 
You may also want to select a specific surface you would like to use as a basis for marking the 
new topo surface.   

 Mark the desired stock pile by drawing a polygon around it with single left mouse clicks, and 
close with a left mouse double click. 

 

 

Figure 95 - Marking a Stock Pile on Dense Point Cloud 
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 Once the polygon is closed a new 3D display shows the marked stock pile in top view, which you 
can rotate to view from different angles.  Here you may also change the stock pile smoothing 
level using the slider at the bottom of the display 

 

Figure 96 - Stock Pile Smoothing 

 Once you are satisfied with the smoothing level, press the “Apply” button to finalize the stock 
pile definition.  This will show the dialog below to allow you to put the stock pile in an existing 
or new surface.   Only Cloud surfaces may be used.  

 

Figure 97 - Adding a Surface 

 Select the options you desire, set the color of the surface and press OK.  You will then see the 
surface defined as topo points over the dense point cloud, and the surface used will be selected. 
This surface will be marked as a cloud surface. See figure below. 
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Figure 98 - Defined Topo Surface 

 

6.7.3.3 Importing surfaces from external sources 

To import and external surface perform the following steps: 

 Click on Import surface from file below the surface list. The “Import Surface from File”.  

 Browse to the required points XYZ file, parse the point lines as needed and click on Import. The 
“Import Surface from Point File” window closes and the “Add Surface” window opens. 

 Type a name and description for the new surface (by default the surface will get the file name) 
and set the surface color (by default the color will be as different as possible from the colors of 
the existing surfaces). 

 Click OK. The file’s points will be imported to the new Surface object. 



 
 

 

- 92 - 

 

Figure 99: Import Surface from Points File Window 

 

Figure 100: Add Surface Window 

  

6.7.3.4 Calculating Volume 

To calculate volumes perform the following steps: 

 Make sure that the “Surfaces” list is populated with at least one Surface object. If the current 
job already has a Layer object containing measured points, they will automatically be converted 
to Surface objects and displayed in the “Surfaces” list.  Such surfaces are labeled as Layer 
surfaces. 

 Surface objects can be added by importing points from an XYZ file as described in section 6.7.3.3 
above. Such surfaces are labeled as Imported surfaces. 

 Surface objects may also be added on the dense point cloud as described in section 6.7.3.2 
above.  Such surfaces are labeled as Cloud surfaces. 

 All surfaces will also appear in the “Base Surfaces” dropdown list. In the “Surfaces” list, using 
the checkboxes in the left column, check the surfaces to be displayed. Revise them and 
determine if they are ready for volume calculation. 
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 The following user interface controls can help during the visually scanning of the surface prior 
to calculating the volume. 

o If a point is identified as erroneous, it can be deleted by performing the following steps: 

 Hover over the point; the point name is displayed. 

 Zoom in to the point. 

 Right-click on the point. 

 Click on Add to Delete Queue, if this is the first point you mark for deletion it will 
also open the “Delete Points” dialog, where you can see and edit what you plan on 
deleting. 

 Once you are done, Click on Delete Points to delete all points in the list (Figure 101). 

Only Topo-points can be deleted. New points may be deleted from the “Approve” tab. 

o If the surface is not accurate go to the “Measure & Draw” window in order to draw more 
topo-surfaces or to add new points where needed. 

 

Figure 101: Deleting the Selected Points 

 After a surface is selected (from the “Surfaces” list), click on Calculate Volume or add a base 
surface from the “Base Surfaces” list to the calculation and then click Calculate. The surface 
volume is calculated and displayed in the “Calculated Volume Properties” window (Figure 102). 
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Figure 102: Calculated Volume Properties Window 

 If only one surface is used for the volume, the “Calculated Volume Properties” window 
shows the surface used for the volume calculation. If two surfaces (surface and base surface) are 
used for the volume calculation, both surfaces will be displayed in the window. 

The window shows the Fill and Cut calculated values in the measuring unit used throughout the job 
(m3 or ft3). 

Throughout this document: 

 

“Fill” refers to the amount of material accumulated above the base ground level. 
“Cut” refers to the amount of material subtracted below the base ground level. 

 To name the volume, as it will be seen in the “Volumes” list, add a name in the “Calculated 
Volume Properties” window, . The calculated volume can be added to the “Volumes” list by 
clicking Add to Volumes. The volume is added as a new record to the list of volumes. 

 When all volume calculations are completed and added to the “Volumes” list, a volume report 
can be exported. Two types of file formats can be exported: PDF and CSV. From the “Export File 
Format” section, select the desired format and click Export….. 
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Figure 103: Volume Calculation – PDF Report 

6.7.3.5 Possible Actions on Surfaces 

Several functions can also be utilized on surfaces to enhance volume calculations. 

Changing Surface Proprieties 
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 To change surface properties, right-click Surface in the “Surfaces” list to access its context menu. 
Select Properties. 

 In the “Surface Properties” window modify the Surface name, description and color. 

 

Figure 104: Surface Properties Window 

Exporting Collected Points on a Surface 

 To export point collected on a surface, right-click Surface in the “Surfaces” list. 

 In the context menu, select Export to Points File, a window opens.  

 Define the file location and name, and a file is saved in ASCII format with XYZ coordinates. 

Removing a Surface from the Surfaces List: 

 To remove a surface from the “Surfaces” list, right-click Surface in the “Surfaces” list to access 
its context menu. 

 Select Delete. 

If the Surface is based on a Layer, this menu option will be grayed out and may not be 
used. Only imported and cloud surfaces can be deleted. 

Cloning a Surface 

 To clone a surface point collected on a surface, right-click Surface in the “Surfaces” list, and 
select “Clone…”. 

 In the “Add Surface” shown select where you want to save the cloned surface and its properties.  

Setting a shared height for a Surface 

 To flatten a surface by setting the height of all its points to a common point, right-click Surface 
in the “Surfaces” list, and select “Set shared height…”. 

 Select the desired height from the available options, and click OK.  

 Be extremely careful when you use this option, as it will change the height in the defined 
surface.  Meaning that this should most likely be done on a cloned surface. 
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6.7.3.6 Possible Actions on Calculated Volumes 

Additional functions can also be utilized on calculated volumes. 

Changing Volume Properties 

 To change volume properties, right-click Volume in the “Volumes” list to access its context 
menu. 

 Select Properties and the “Calculated Volume Properties” window opens. Here you can modify 
the volume name. 

 

Figure 105: Calculated Volume Properties Window 

Recalculating a Volume 

 To recalculate a volume, right-click Volume in the “Volumes” list to access its context menu. 

  Select Recalculate…. This option lets you update the volume value in the event that one of the 
surfaces involved has been changed. The “Volume Recalculation Properties” window opens 
letting you view the changes in the volume values. 

 Update the value for Volume or leave it as is. The date and time where the last calculation was 
made is also displayed. 
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Figure 106: Volume Recalculation Properties Window 

Removing a Volume from the “Volumes” List 

 To remove a volume from the “Volumes” List, right-click Volume in the “Volumes” list to access 
its context menu. 

 Select a particular volume and then click Delete. The volume will be removed from “Volumes” 
list. 

6.7.4  DTM Grid Generation 

6.7.4.1 Background 

DTM grid generation is done based on an area that the user selects.  The selection of the area is 
done on the dense point cloud exactly as it is done for volume calculation.  Once a DTM surface is 
created it can be treated exactly as any other topo surface. 
 

6.7.4.2 Marking a DTM Area on Dense Point Clouds  

To mark a DTM area, perform the following steps: 

 Make sure a dense point cloud was generated for the selected cluster.  

 In View & Export, select the DEM & Volumes tab.   

 Select the DTM surface marking tool (  ).   

 Mark the desired surface by drawing a polygon around it with single left mouse clicks, and close 
with a left mouse double click or by pressing the Enter key. 
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Figure 107 - Marking a DTM Area on Dense Point Cloud 

 Once the polygon is closed you will be asked to mark the grid direction simply by clicking on any 
two points in the grid.  Click OK and click on any two point in the direction you desire. 

 

 Once this is done, you will be asked to select your DTM filtering parameters and the size of the 
grid in the window shown below.    
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Figure 108 - DTM Parameters 

 Set the desired parameters and click OK.  The system will then allow you to select the surface 
you want to add to this area or to add a new surface.   

 

Figure 109 - Adding a DTM Surface 

 Select the options you desire, set the color of the surface and press OK.  You will then see the 
surface defined as a grid over the dense point cloud, and the surface used will be selected. This 
surface will be marked as a DTM surface. See figure below. 
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Figure 110 - Defined DTM Surface 

6.7.4.3 Exporting a DTM file 

To export a DTM grid file,  

1. Right click on the DTM line in the list on the right, 

. 

2. Select Export to Points File. 

3. In the window below select a file name, location, and file type.  PNT of DXF is possible. 
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When DXF export is used the bounding polygon defining the area is also exported as an 
object as well to the DXF file.  

4. Press Save. 
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7 DatuSurvey™ Menu Options 
This chapter explains some of the menu options where their use is not self-explanatory or items that 
have not been previously explained in this document. 

7.1 File Menu 

7.1.1  Save as… 

The function saves the current job under a new name. The user continues to work with the newly 
saved job and if changes are made to the newly-named job the previous version is not affected.  

7.1.2  Export 

This is similar to the “Save as” function except that the current job is saved under a new name and 
(optionally) format (for Export) while the user continues to work on the current job. 

7.1.3  Close & Archive Job 

This is similar to the “Close Job” function except that it performs a temporary file cleanup to free 
disk space. This option should be used when the project has been completed. “Close Job” does not 
clean up temporary files, hence opening the job next time will be faster than after “Close & Archive 
Job”. 

7.2 Tools Menu 

7.2.1  Camera Viewer 

Camera Viewer is a help tool to allow the user to see location and orientation of the images before 
the link, after the link, or both.   

 

Figure 111: Camera Viewer 



 
 

 

- 104 - 

7.2.2  Settings Window 

The “Settings” windows provide control over basic configuration settings for DatuSurveyTM. 

To access the “Settings” window, click Tools > Settings. 

7.2.2.1 General Settings 

 

 

Figure 112: The General Settings Window 

The Working Folder is the location where DatuSurveyTM stores its temporary data. In order for 
DatuSurveyTM to perform properly, its working folder should be located on a local drive (SSD is 
preferred), and not on network drive. 

Under Localization section select the interface language you want to use from the drop down list. 

In some computers associated with networks, it is common for folders that contain users’ 
documents to reside on network storage by default. For regular documents (word processing, 
working sheets, etc.) this is quite acceptable but it will not foster effective work with DatuSurveyTM. 
DatuSurveyTM performs a vast number of image and mathematical processing and needs a fast 
storage device. Only local storage devices can provide sufficient performance results. Because of 
this, it is recommended that the DatuSurveyTM working folder resides on a local drive. An SSD is 
recommended. 



 
 

 

- 105 - 

7.2.2.2 Measurement Units 

 

Figure 113: The Measurement Units Window 

In the “Distance units” dropdown box, the following measurement units can be selected: 

 Meter 

 US Foot 

 International Foot 

 Yard 

In the “Volume Units” dropdown box, the following measurement units can be selected: 

 The distance units "Meter" can work with volume units of “Meter” only 

 The distance units "US-Foot" can work with volume units of either “US-Foot” or “Yard” 

 The distance units "Int. Foot" can work with volume units of either “Int. Foot” or “Yard” 

Click OK to set the measurement unit for the whole job. 
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7.2.2.3 Accuracy Display 

 

Figure 114: The Accuracy Display Window 

Set the range of residual measurement errors (green, yellow or red) as displayed in the Quality 
Control report (as a fraction of meters). 

7.2.2.4 Interior Orientation 

 

Figure 115: The Interior Orientation Window 

Modify the information in this table in order to change measurements used by DatuSurvey™ to 
establish residual values. 
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7.2.2.5 SBA 

 

Figure 116: SBA Window 

In the “Geo-Ref / Scale” window, click Apply to modify which points will be used in the SBA 
(Sparse Bundle Adjustment) calculation. Caution should be used when setting these options, as 
although they will improve the accuracy of the model, they may slow the process of calculations. 

7.2.2.6 Advanced 

This tab is used to set advanced software options as shown in the figure below. 

 

Figure 117: Advanced Settings Window 
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It is strongly recommended not to change the settings here without consulting with Datumate 
support staff.  

The most important option here is using the multi block linkage which saves many hours of linkage 
especially in large jobs opened as vertical jobs.   If the multi block linkage fails you will be notified 
and given the option to link it using the standard mode.  The multi block linkage may save up to 80% 
of the linkage time. 
 

7.2.3  Managing and Using Codes and Blocks 

Codes and blocks are attributes of map entities used in most common surveying CAD software. 

7.2.3.1 Managing Codes 

Code is metadata associated with a map entity that relates it to a specific family of entities. For 
example, code could indicate that a specific new-point entity is part of the entities related to 
mapping window frames or semaphores. A code has a name and a description. Each map entity can 
only have one code. 

In DatuSurvey™ each new-point entity has an associated code. By default, a new point has the code 
named “0” with description “Default”. You can change the new-point code to one of the codes that 
exist in the job’s codes library. In order to have codes in the codes library, you must load its 
commonly used list of codes from the job. 

Working with the “Point Codes Library” Window 

 To access the “Point Codes Library”, click Tools > Point Codes Library. The following functions 
are available: importing a codes library file, exporting a job’s codes to file, creating a new code, 
editing an existing code or deleting one. 

 

Figure 118: Point Codes Library Window 

Importing Codes Library File 
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 Click Import. 

 Select the codes library text file. Figure 119 shows an example of an importable point code text 
file. 

 

Figure 119: Point Code File 

 Confirm the import. 

 

Figure 120: Point Codes Loaded from Codes Library File 

If the system encounters names of existing codes, the “Naming Conflict” dialog box offers 
options to skip, rename or overwrite the point. 

Exporting Job’s Codes to a Text File 

 Click Export. 
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 Type the name of the file to hold the exported codes library. Output file format will be as shown 
in Figure 119. 

 Confirm the export. 

Creating new Point Code 

 Click New. 

 

Figure 121: Add New Point Code Window 

 Type the name and description for the new code. 

 Click OK. A new point code is added to the job’s codes library. 

Editing an Existing Point Code 

 From the point codes list, select the code you wish to change. 

 Click Edit. 

 

Figure 122: Editing an Existing Point Code –Edit Point Code Window 

 Edit the name and/or description of the code. 

 Click OK and the changed code values are saved. 

Deleting an Existing Point Code from the Job’s Codes Library 

 From the point codes list, select the code you wish to delete. 

 Click Delete. 

Using Blocks 
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A Block is the unit used by surveying software applications to store metadata associated with 
mapping entities and the graphical symbol representation of the entity. Thus, a block is a data 
structure that combines an icon and metadata attributes. In DatuSurvey™ blocks are used when the 
surveying map is exported to DXF format. 

Each new-point entity is associated with a block that has the same graphics symbol and the following 
attributes: 

Attribute Number Attribute Name Attribute Data Type 

1 Point Name text 

2 Point Comment text 

3 Code Name text 

4 Code Description text 

5 North double 

6 East double 

7 Elevation double 

8 Accuracy North double 

9 Accuracy East double 

10 Accuracy Elevation double 

11 Measurement Unit string 

7.2.4  Client License Manager 

This option is only available when a network license is used and permits a user to borrow a network 
license that is not in use for a period of time. If not done previously, when the time period expires 
the license is returned to the network server automatically. 

 Borrowing and returning a license can be done only while no job is open. 

7.2.4.1 Borrowing a Network License 

 To borrow a network license select the menu option “Tools/Client License Manager” (Figure 
123). An external application will start and display a list of products that are available (Figure 
124). 
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Figure 123: Client License Manager 

 

 

Figure 124: Borrowing a Network License 

 If there are no licenses available (Figure 125), log out of the DatuSurvey™ application on one of 
the computers where it is running in order to release a license. 

 Click Refresh to see the list of available products again. The release process may take up to a 
few minutes. 
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Figure 125: No Licenses Available 

 If Datumate software licenses are available simply select one, set the Borrowing time duration 
to any number of days from 1 to 14, and click on Borrow License. From this point DatuSurvey™ 
will be using a local borrowed license, and the license will not be available on the network for 
other users. If you set a borrowing duration time that takes you beyond the license expiration 
date, the expiration of the borrowed license will be automatically set to the license expiration 
date. 

7.2.4.2 Returning a Network License 

There are two ways a borrowed license can be returned and made available to other users as 
follows: 

 Automatically when the time set for the borrowing period expires, even if the borrowing 
computer is connected to the network or not. 

 Manually by the user - This option requires accessing the “Client License Manager” application 
(Section 7.2.4 ) using the return license option (Figure 126). 

 

Figure 126: Returning a Network License 

7.2.5  Generate Dense Point Cloud 

When available, this option allows the generation of dense point clouds for all clusters. When Dense 
Point Clouds are generated they override any previously generated clouds. When this option is 
selected, the DPC Parameters window will open to allow the selection of all the different options 
including density level and output type.  
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Figure 127 - Dense Point Cloud Parameters 

Additionally, it is possible to select an area or region of interest for which you would like to generate 
the point cloud. To do so, and before clicking the “Generate” button, check the “Select ROI First” 
check box.  Then when you click on “Generate”, you will be given the option to select the area. 
 
If more than one cluster is available, the selection option will be given for each cluster separately.  
Also, for each cluster you will be given the option to skip the area selection and continue to the next 
cluster.  Skipping the selection means that the full dense point cloud will be generated. 
 

7.2.6  Reset Images Linkage 

This will allow you to cancel the linkage to be able to switch the RTK mode on or off, or for any other 
reason a reset is needed.    
 
 

7.3 View Menu 

7.3.1  Point Cloud 

The menu option allows you to open the Point Cloud display and to move between clusters (Figure 
128).  It displays the most recent point cloud available; Sparse or Dense.  
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Figure 128: Sparse Point Cloud Window 

Additionally, it allows you to export the points of any cluster to an external .ply file that can be 
opened using other software packages, such as “Cloud Compare” and “MeshLab”. 

7.4 Help Menu 

The following sections present the main Help menu options. 

7.4.1  About DatuSurvey™ 

Clicking About opens the “About” window. This window shows the product Name, Version, License 
information, and other applicable messages. Figure 129 is displayed if you have a valid perpetual 
license with a maintenance agreement that expires in more than 30 days. 
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Figure 129: About Window – Valid Perpetual License 

If you have a valid time-based license and the expiration is more than 14 days away, you will see the 
following window. 

 

Figure 130: About Window – Valid Time-Based License 

In other cases where you have a perpetual license and the maintenance agreement is about to 
expire, or you have a time-based license and the license is about to expire, the “About” window will 
provide a reminder (Figure 131). These messages may also appear at startup when the automatic 
check for update is done, but will be labeled “Validate Maintenance” or “Validate License”. 
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Figure 131: About Window with Reminders 

If you have a perpetual license and the maintenance agreement date is not found or has already 
expired, the “About” window will notify you accordingly (Figure 132). These messages may also 
appear at startup when the automatic check for update is done, but will be labeled “Validate 
Maintenance” or “Validate License”. 
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Figure 132: About Window with Expiry and Renewal Notices 

If you have a time-based license and the license has already expired, the “About” window will notify 
you accordingly (Figure 133). This is assuming that the license expired while the software was 
already running. 
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Figure 133: About Window with Expiry Notices 

If the time-based expiration was detected at startup, the system will present a notification (Figure 
134) and will not allow you to continue, unless you have a new license ID that you want to update, 
in which case you may click the “Update License” button and update the license ID and key. 

 

Figure 134 – Expired License Message 

7.4.2  Checking for DatuSurvey™ Software Update 

Click on “Check for Update”, so that DatuSurvey™ will communicate with Datumate’s server to look 
for a newer version of the application. If a new version is found and you have a valid maintenance 
agreement, DatuSurvey™ will inform you that a newer version exists and it can be downloaded 
(Figure 135). Follow instructions to download and save the installation file. After the installation file 
is downloaded, the installation starts automatically. 
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Figure 135: Software Update Window 

If a new version is found and you do not have a valid maintenance agreement, DatuSurvey™ will 
inform you that a newer version exists and it can be downloaded (Figure 136). 

 

Figure 136: Version Available But No Maintenance Agreement Message 

If the most recent version is installed, an appropriate notification is displayed (Figure 137). 

 

Figure 137: Version Up-to-Date Message 

7.4.3  Opening the Welcome Screen 

 Click on the Welcome Screen to open the “Welcome” window. 
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Figure 138: Welcome Screen 

The “Welcome” window is divided into three columns: 

Left Column – Mini Jobs Manager: The left column is the Recent Jobs manager. Clicking on the Start 
button, in the top square, opens the help menu that has a Start button which activates the “Job 
Properties” window used to create a new job. 

The bottom square contains a list of links with names of recent jobs. Clicking on a link will open the 
linked job. Clicking the Open Job button will open a file dialog to let you select and open an already 
existing job. 

Middle Column – Video Tutorials: The middle column contains internet hyperlinks to DatuSurvey™ 
video tutorials. Clicking on each Play button will open the appropriate video in the system’s default 
browser. This feature requires Internet connection and the latest version of Flash Player, or using 
the Google Chrome browser. 

Right Column – Sample Jobs: The right column contains links to several guided sample jobs, stored 
on the Datumate’s server. To use and learn from a sample job, download the job from Datumate’s 
server to your PC (click Download), and click Open to view the job within DatuSurveyTM. Follow 
instructions in the manual to work with these jobs. 

7.4.4  Basic Steps Presentation 

 Click on Before You Start to open a series of pages containing explanations about the basic steps 
for using DatuSurvey™ (Figure 139 is the first slide of this series). 
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Figure 139: First Slide from Basic Steps Presentation 
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8 Appendices 
This chapter explains external processes and best practices that may need to be done in preparation 
for using this software. 

8.1 Appendix 1 – Marking Ground Control Points 
 

This section describes the best practices for marking Ground Control Points based on the area to be 
measured. 

8.1.1  GCP Accuracies 
 

Ground control points accuracies in relation to desired topographic mapping scale: 
 

Num. Map Scale Accuracy – RMS in 95% CL [cm] Pixel foot print 
[cm] Horizontal (N, E) Vertical  

(H) 

1 1:250 ± 2 ± 2 2.5 

2 1:500 ± 5 ± 5 5.0 

3 1:1250 ± 10 ± 10 12.5 

4 1:2500 ± 20 ± 20 25.0 

5 1:5000 ± 50 ± 50 50.0 

6 1:10,000 ± 60 ± 60 100.0 

     

  
 

8.1.2  GCP Distribution for elongated areas 
 

Ground control points distribution recommendation in relation to desired topographic mapping 
scale for elongated projects: 
 

Num. Map Scale 2 GCP in both 
project side in 
each DL or DW 

[m] 

Accuracies in 
MSE in 95% 

[cm] 

Pixel foot print 
[cm] 

1 1:250 50.0 ± 12 2.5 

2 1:500 100.0 ± 25 5.0 

3 1:1250 250.0 ± 30 12.5 

4 1:2500 500.0 ± 40 25.0 

5 1:5000 1000.0 ± 80 50.0 

6 1:10,000 2000.0 ± 120 100.0 
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 Convex hall polygon consisting of GCP’s must cover all the ROI as shown in the figure 

below.  

 User must add GCP along the ROI on both sides. 

 

 
 

8.1.3  GCP Distribution for polygonal areas 
 
 

Ground control points distribution recommendation in relation to desired topographic mapping 
scale for polygonal (area) projects: 
 

Num. Map Scale 1 GCP in each 
square  DL X DL 

in 
[m] 

Accuracies in 
MSE in 95% 

[cm] 

Pixel foot print 
[cm] 

1 1:250 50.0 ± 12 2.5 

2 1:500 100.0 ± 25 5.0 

3 1:1250 250.0 ± 30 12.5 

4 1:2500 500.0 ± 40 25.0 

5 1:5000 1000.0 ± 80 50.0 

6 1:10,000 2000.0 ± 120 100.0 

 

 Convex hall polygon consisting of GCP’s must cover all the ROI circumference. 

 User must add one control point in each DLxDL. 

 

DL 
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About Datumate 

Datumate is a leading vendor of geodetic expert systems. Datumate’s software products, which 
incorporate technological innovation and geodetic expertise, support land surveyors worldwide by 
improving productivity of field personnel, quality control and management of surveying project. 
Among Datumate’s customers are the Survey of Israel, Israel’s national mapping agency, as well as 
numerous leading land surveying firms worldwide. 

To learn more, please refer to: www.datumate.com 

 

 


